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4.3.0-TraceCompassTestCases Summary

New Bug Reports found Open Fixed Total
Bug Reports 0 0 0
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To Do

Section Comment

Integration

Target:
Step Test Case Action Verification Comment

1  Verify C/C++ EPP Package RC1

1.1 Download EPP Package Download, extract and start EPP package EPP Package starts Manual Pass
Verify that all tracing features and plug-ins are
Version of Tracing Features present and have the correct version (TMF,
1.2 Go to Help -> About Eclipse -> Installion Details LTTng, CTF, GDBTrace, PCAP/PCAPNG) Manual Pass
13 TMF presence Open Tracing perspective Tracing perspective opens Manual Pass
1.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual Pass
1.5 Network Tracepoint Analysis presence ~ Open GDB Trace perspective GDB Tracepoint analysis perspective Manual Pass

Go to Help -> Install New Software... -> Update site
"2019-03 - http://download.eclipse.org/staging/2019-  Verify that all LTTng Kernel, LTTng UST and GDB
1.6 2019-03 Update Site 03/" Manual Pass

2  Verify C/C++ EPP Package RC2
Download, extract and start EPP package. Check the m
2.1  Download EPP Package https://dev.eclipse.org/mailman/listinfo/epp-dev EPP Package starts Manual Pass
Verify that all tracing features and plug-ins are
Version of Tracing Features present and have the correct version (TMF,
22 Go to Help -> About Eclipse -> Installation Details LTTng, CTF, GDBTrace, PCAP/PCAPNG) Manual Pass
2.3 TMF presence Open Tracing perspective Tracing perspective opens Manual Pass
24  LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual Pass
2.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual Pass
2.7 PCAP/PCAPNG presence Open Network perspective Network perspective opens Manual Pass
Go to Help -> Install New Software... -> Use the
testing update site "2019-03 - http://download.eclipse. Verify that all LTTng Kernel, LTTng UST and GDB
2.6 2019-03 Update Site org/staging/2019-03/" Manual Pass
3  Verify C/C++ EPP Package RC3
3.1  Download EPP Package Download, extract and start EPP package EPP Package starts Manual N/A
Verify that all tracing features and plug-ins are
Version of Tracing Features present and have the correct version (TMF,
32 Go to Help -> About Eclipse -> Installation Details LTTng, CTF, GDBTrace) Manual N/A
3.3 TMF presence Open Tracing perspective Tracing perspective opens Manual N/A
3.4  LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual N/A
3.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual N/A
3.6 Network Tracepoint Analysis presence  Open Network Trace perspective Network Tracepoint analysis perspective Manual N/A
Go to Help -> Install New Software... -> Use the
testing update site "2019-03 - http://download.eclipse. Verify that all LTTng Kernel, LTTng UST and GDB
3.6 2019-03 Update Site org/staging/2019-03/" Manual N/A
4  Verify C/C++ EPP Package RC4
4.1 Download EPP Package Download, extract and start EPP package EPP Package starts Manual N/A
Verify that all tracing features and plug-ins are
present and have the correct version (TMF,
Version of Tracing Features LTTng Control, LTTng Kernel, LTTng UST, CTF,
42 Go to Help -> About Eclipse -> Installation Details GDBTrace) Manual N/A
43 TMF presence Open Tracing perspective Tracing perspective opens Manual N/A
4.4  LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Manual N/A
4.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Manual N/A
Go to Help -> Install New Software... -> Use the
testing update site "2019-03 - http://download.eclipse. Verify that all LTTng Kernel, LTTng UST and GDB
4.6 2019-03 Update Site org/staging/2019-03/" Manual N/A
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5

5.1

52

5.3

5.4

5.5

6.1

6.2

'Verify Update Site

2019-03 Update Site

Trace Compass Update Site

Upgrade using 2019-03 Update Site

Upgrade using Trace Compass Update
Site

Upragde from previous EPP

‘Verify Update Site

Trace Compass update site

Upgrade using Trace Compass
update site

Download Eclipse for Committers and install LTTng

Kernel, LTTng UST, GDBTrace and PCAP Network

Analysis from main simrel testing Update site

"2019-03 - http://download.eclipse.org/staging/2019-

03/" Verify that installation was successful

Download Eclipse for Committers and install LTTng
Kernel, LTTng Control, LTTng UST, GDBTrace and
PCAP Network Analysis from the Linux Tools Update
site

http://download.eclipse.
org/tracecompass/photon/milestones

Download Eclipse for Committers from Photon.0 and

install LTTng, LTTng Kernel, GDBTrace and PCAP

Network Analysis from main simrel Update site.

http://download.eclipse.org/releases/photon

Try to update the installation using the testing simrel

update site.

http://download.eclipse.org/staging/2019-03/ Verify that installation was successful

Download Eclipse for Committers from Photon.0 and
install LTTng, LTTng Kernel, LTTng UST, GDBTrace
and PCAP Network Analysis from the Trace Compass
release Update site.
http://download.eclipse.org/tracecompass/releases/4.
3.0/repository

Try to update the installation using the Trace
Compass update site http://download.eclipse.
org/tracecompass/photon/milestones

Download Eclipse previous C/C++ EPP package. Try
to upgrade using both update sites:

(TODO find correct job: https://hudson.eclipse.
org/packaging/job/luna.epp-tycho-
build/128/artifact/org.eclipse.epp.
packages/archive/repository/)

"Mars - http://download.eclipse.
org/releases/maintenance”

Verify that installation was successful

Verify that installation was successful

The information about the update sites to use is

_usually posted on epp-dev _Verify that installation was successful

Release outside release train

Download Eclipse standard and install LTTng Kernel, L’
UST, GDBTrace and PCAP Network Analysis from mai
Update site: http://download.eclipse.org/tracecompass/s Verify that installation was successful

Download Eclipse standard from Photon SR0O and
install LTTng, LTTng Kernel, LTTng UST, GDBTrace
and PCAP Network Analysis from the Trace Compass
update site:

http://download.eclipse.

org/tracecompass/stable/repository/ Verify that installation was successful

Manual

Manual

Manual

Manual

Manual

Manual

Manual

N/A

N/A

Integration
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Section Pass Fail ToDo Comment

Junit Tests 18 [ o o

Target: Ubuntu 12.04 64 bit and on Hudson

Step Test Case Action Verification Comment

1  Junit Test Cases

1.1 CTF Core Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.2 CTF Parser Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.3 State System Core Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.4  TMF Core Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.5 TMF UI Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.6 TMF UI SWTBot Tests Plug-in Run manually or with Jenkins All test cases passed Pass
CTF Support for TMF SWTBot

1.7 Tests Plug-in Run manually or with Jenkins All test cases passed Pass
TMF Xml Analysis Core Tests Plug-

1.8 in Run manually or with Jenkins All test cases passed Pass

1.9 TMF Xml Analysis UI Tests Plug-in Run manually or with Jenkins All test cases passed Pass

1.10  LTTng Control Core Tests Plug-in ~ Run manually or with Jenkins All test cases passed Pass

1.11 LTTng Control UI Tests Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Kernel Analysis Core Tests

1.12  Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Kernel Analysis UI Tests

1.13  Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Kernel Ul SWTBot Tests

1.14  Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Userspace Tracer Analysis

1.15  Core Test Plug-in Run manually or with Jenkins All test cases passed Pass
LTTng Userspace Tracer Analysis Ul

1.16  Test Plug-in Run manually or with Jenkins All test cases passed Pass
GDB Tracepoint Analysis Core Tests

1.17  Plug-in Run manually or with Jenkins All test cases passed Pass
GDB Tracepoint Analysis UI Tests

1.18  Plug-in Run manually or with Jenkins All test cases passed Pass
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Section
TMF - Project View

Target: Ubuntu 16.04 64 bit

Step

22
2.3

3.1
32

Test Case

Preparation
Step 1

Step 2

Project Creation
New Project Wizard

Create project
Project structure

Traces Folder

Preparation
Traces Folder menu
Trace Import Wizard

Pass
149

Action

Open LTTng Kernel perspective

Open Navigator View (used for independent
verification)

Open New Tracing Project Wizard

Specify a project name and finish
Open the new Tracing project

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import Custom Text and XML parsers
(ExampleCustomXmlParser.xml,
ExampleCustomTxtParser.xml) from
directory traces/customParsers into your
workspace from the Manage Custom Parsers
dialog.

Select the Traces folder and open its context menu
Select Import

1) Browse to directory ${local}/traces/import/

2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning" and select "Create Links to

Import single custom text trace (link to workspace" and

workspace)

Import Single custom XML trace (link redo 3.1-3.3 but this time select ExampleCustomXml. Trace Type "Custom XML log" is set. Make sure

to workspace)

Import LTTng Kernel CTF trace (link
to workspace)

Rename + copy import

Overwrite + copy import

Skip

Default overwrite

4) press Finish

xml

redo 3.1-3.3 but this time select directory kernel-
overlap-testing/

redo 3.3, 3.4, 3.5. However, Unselect "Create Links
to workspace"

‘When dialog box appear select Rename

redo 3.3, 3.4, 3.5. However, Unselect "Create Links
to workspace"

When dialog box appear select Overwrite

redo 3.3, 3.4, 3.5. However, Unselect "Create Links

to workspace"

‘When dialog box appear select Skip

redo 3.3, 3.4, 3.5. However, Unselect "Create Links

Fail

Verification

LTTng perspective opens with correct views

Navigator View opens

Tracing Project Wizard opens

Tracing project appears in Project
Explorer/Navigator

Project contains Experiments and Traces folders

Correct menu opens (Import, Refresh)

Trace Import Wizard appears

Imported trace appear in Traces Folder and the
Trace Type Tmf Generic is set. Make sure trace
can be opened

Imported trace appear in Traces Folder and the

that trace can be opened
Imported trace appear in Traces Folder and the

Trace Type "LTTng Kernel" is set. Make sure
that trace can be opened

Traces are imported with new name that has a
suffix (2) at the end. Make sure that imported
traces are copied to the project.

Existing traces are deleted and new traces are
imported. Make sure that imported traces are
copied to the project and can be opened

Make sure that no new trace is imported

Make sure that no dialog box appears (for
renaming, overwriting, skipping) and existing

to workspace" and select "Overwrite existing without traces are overwritten). Make sure trace can be

warning"

opened

Type

Manual

SWTBot

SWTBot

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

To Do

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Comment
13

Comment

ProjectView
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3.10

3.11

3.12

3.13

3.14

3.15

3.16

3.17

Import unrecognized

Import unrecognized (ignore)
Preparation

Import CTF trace by selection
metadata file only

Preparation

Recursive import with auto-detection
(Rename All)

Preparation

Recursive import with auto-detection
(Overwrite All)

Preparation

Recursive import with auto-detection
(Skip All)
Preparation

Recursive import with auto-detection
(test rename, overwrite and skip)

Preparation

Recursive import with specific trace
type 1 (Skip All)

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning" and select "Create Links to
workspace" and

5) press Finish

redo 3.10, however unselect "Import unrecognized
traces"

Delete all traces in project - Right mouse
click on Traces folder and select "Clear"

Redo 3.5, However only select metadata file instead
of directory trace

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory $ {local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning", select "Create Links to workspace"
and unselect "Preserve Folder Structure”

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning", select "Create Links to workspace"
and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select Overwrite All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning" and select "Create Links to
workspace" and uncheck "preserve folder structure"
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import
unrecognized traces", unselect "Overwrite existing
without warning", select "Create Links to workspace"
and unselect "Preserve Folder Structure”

5) press Finish

6) When dialog appears select "Rename"

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select
"Import unrecognized traces", unselect "Overwrite
existing without warning", select "Create Links to
workspace" and unselect "Preserve Folder Structure”
and

5) press Finish

6) When dialog appears select Skip All"

unrecognized.log is imported with trace type
unknown. The default text file icon is displayed.
The trace, when opened, is displayed in the text
editor.

unrecognized.log is not imported

Imported trace appear in Traces Folder and the
Trace Type "LTTng Kernel" is set. Make sure
that trace can be opened

All Traces are imported with respective trace
type set. Traces with name clashes are imported
with suffix (2). 1 trace (unrecognized.log) is
imported with trace type unknown. Make sure
that traces can be opened which have a trace type
set. The unknown trace type should open with
the text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are
overwritten . | trace (unrecognized.log) is
imported with trace type unknown. Make sure
that traces can be opened which have a trace type
set. The unknown trace type should open with
the text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are not
imported. 1 trace (unrecognized.log) is imported
with trace type unknown. The unknown trace
type should open with the text editor.

All Traces are imported with respective trace
type set. Traces with name clashes are either
renamed, overwritten or skipped as per dialog
action. Make sure that traces can be opened
which have trace type set. The unknown trace
type should open with the text editor.

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

4 CTF traces are imported with trace type
"Generic CTF Trace" . Make sure that these
traces can be opened

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

ProjectView
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3.18

3.19

3.20

3.21

3.22

3.23

3.24

3.25

3.26

327

3.28

Preparation

Recursive import with specific trace
type 2 (Skip All)
Preparation

Recursive import with specific trace
type 3 (Skip All)
Preparation

Recursive import with specific trace
type 4 (Skip All)
Preparation

Import wizard from workbench menu
with project selected

Import wizard from workbench menu
with no project selected
Preparation

Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with existing
name

Drag and Drop of trace with existing
name (2nd time)

Import destination
Preparation

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select
"Import unrecognized traces", unselect "Overwrite
existing without warning", select "Create Links to
workspace" and unselect "Preserve Folder Structure”
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng UST Trace", Select
"Import unrecognized traces", unselect "Overwrite
existing without warning", select "Create Links to
workspace" and unselect "Preserve Folder Structure”
5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import
unrecognized traces", unselect "Overwrite existing
without warning", select "Create Links to workspace"
and unselect "Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Select project "Test" in Project Explorer view

2) Open import wizard from menu File > Import... >
Tracing > Trace Import

3) Browse to directory $ {local}/traces/import/

4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to
workspace" and

6) press Finish

1) Clear selection in Project Explorer view

2) Open import wizard from menu File > Import... >
Tracing > Trace Import

3) Browse to directory $ {local}/traces/import/

4) Select trace ExampleCustomTxt.log

5) Keep <Auto Detection>, select "Create Links to
workspace" and

6) press Finish

Delete all traces in project

D&D a few LTTng traces from another Tracing
project's Traces folder

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

1) D&D a trace with name of an existing trace into
traces folder
2) Confirm the renaming of traces

Redo test 3.26 with the same trace and same
destination folder

Open Import wizard
Delete all traces in project

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace
type "LTTng Kernel Trace". Make sure that this
trace can be opened.

After selecting trace type, verify that button
"Import unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace
type "LTTng UST Trace". Make sure that these
traces can be opened.

All text files in directories are imported as trace
and trace type "Tmf Generic" is set. Note that
trace type validation only checks for file exists
and that file is not a directory. Make sure that
these traces can be opened. However traces with
wrong trace type won't show any events in the
table.

Verify that trace is imported to "Test" project
and can be opened.

Verify that trace is imported to default "Tracing"
project and can be opened.

Selected traces are added to the Traces folder
with proper icon. Trace can be opened.

Selected traces are added to the Traces folder
with default icon. Files can be opened with the
default editor.

Selected traces are added to the Traces folder
with default icon. For actual traces Trace type is
detected automatically. Trace can be opened,
For non traces the files are added with default
icon and they can be opened with the default
editor.

Verify that trace is added into the traces folder
with the trace name of the orignal trace plus a
suffix 2

Verify that trace is added into the traces folder
with the trace name of the orignal trace plus a
suffix 3

Verify that "Into Folder" text box cannot be
updated

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

ProjectView
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3.29

3.30

331

3.32

333

3.34

335

3.36

3.37

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
folder structure (Rename All)

Preparation

Delete with mixed selection of traces
and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder

Preparation

Import from zip archive, preserve
folder structure

Preparation

Import from zip archive, no preserve
folder structure

Preparation

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select "Create
Links to workspace" and select "Preserve Folder
Structure"

5) press Finish

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select "Create
Links to workspace" and select "Preserve Folder
Structure"

5) press Finish

6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect
"Overwrite existing without warning", select "Create
Links to workspace" and select "Preserve Folder
Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Create two trace folders under the "Traces" folder
2) Import 2 traces under each folder

3) Open all 4 traces

4) Select one trace in the first folder and the second
folder in the Project Explorer view

5) Right-click, Delete. Click Yes.

1) Create 2 trace folders under the "Traces" folder
2) Import a trace under each folder

3) Open both traces

4) Select both folders in the Project Explorer view
5) Right-click, Delete. Click Yes

1) Import 2 traces from different folders preserving
folder structure

2 Open both traces.

3 Select the Traces folder

4) Right-click, Clear. Click Yes.

1) Import 2 traces to different projects

2 Open both traces.

3 Select both Traces folders

4) Right-click, Clear. Click Yes.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite
existing without warning" and select "Preserve Folder
Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite
existing without warning" and unselect "Preserve
Folder Structure"

5) press Finish

6) Select Rename All when dialog comes up.

Delete all traces in project

All Traces are imported with respective trace

type set. The folder "clashes" is imported with its

traces inside. Make sure that traces can be

opened which have a trace type set. SWTBot

The wizard should finish quickly as no trace will
be imported. Make sure that traces can be opened
which have a trace type set. SWTBot

All Traces are imported with respective trace

type set with suffix (2). The folder "clashes" is

imported with its traces inside. Make sure that

traces can be opened which have a trace type set. SWTBot

A dialog should ask the user to confirm deletion

of the selected elements. Clicking OK should

remove all that was selected. The editor of the 3

deleted traces should be closed automatically

with one remaining editor opened. SWTBot
A dialog should ask the user to confirm deletion

of the selected elements. Clicking OK should

remove all that was selected. The editor of both

traces should be closed automatically. SWTBot

A dialog should ask the user to confirm clearing

of the folder. Clicking Yes should remove

everything under the selected folder and close

the traces SWTBot
A dialog should ask the user to confirm clearing

of the folders. Clicking Yes should remove

everything under the selected folders and close

the traces SWTBot

All the files get imported under their respective
folders. The CTF traces can be opened (kernel-
overlap-testing, simple_server...) SWTBot

All traces are imported with trace type set. The

traces from folder "clashes" are renamed with

suffix (2). Make sure that the traces can be

opened SWTBot

ProjectView
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3.38

3.39

3.40

341

4.1
4.2

43

4.4
4.5
4.6
4.7

48

4.9

5.1
52

6.1

6.2
6.3
6.4

6.5

Import from zip archive specific traces
Preparation

Import from tar.gz archive, preserve
folder structure

Preparation

Import from tar.gz archive, no
preserve folder structure

Preparation

Import from tar.gz archive specific
traces

Trace
Trace menu

Open trace
Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)
Open Trace (already open)
Experiments Folder

Experiments menu
Create experiment

Experiment
Experiment menu

Select Traces dialog
Select traces
Open experiment

Copy experiment

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.zip

3) select file "z-clashes/ExampleCustomTxt.txt" and
folder "kernel-overlap-testing"

4) Select trace type "Automatic", and select "Preserve
Folder Structure”

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite
existing without warning" and select "Preserve Folder
Structure"

5) press Finish

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select directory the root directory

4) Select trace type "Automatic", unselect "Overwrite
existing without warning" and unselect "Preserve
Folder Structure”

5) press Finish

6) Select Rename All when dialog comes up.
Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Select archive file: traces.tar.gz

3) select file "z-clashes/ExampleCustomTxt.txt" and
folder "kernel-overlap-testing"

4) Select trace type "Automatic", and select "Preserve
Folder Structure"

5) press Finish

Select an LTTng trace and open its context menu
Select the Open menu

Select the Copy menu and provide a new name.
Open.

Select the Rename menu and provide a new name.
Reopen.

Select the Delete menu and confirm deletion
Select trace and press Enter
Select trace and press Delete and confirm deletion

Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context
menu

Select the New menu and provide experiment name

Select an experiment and open its context menu

Select the Select Traces menu
Select a few LTTng traces and finish
Select the Open menu

Select the Copy menu and provide a new name.
Open.

The specified traces are imported with trace type
set. Make sure that the traces can be opened.

All the files get imported under their respective
folders. The CTF traces can be opened (kernel-
overlap-testing, simple_server...)

All traces are imported with trace type set. The
traces from folder "clashes" are renamed with
suffix (2). Make sure that the traces can be
opened

The specified traces are imported with trace type
set. Make sure that the traces can be opened.

Correct menu opens (Open , Copy, Rename, ...)
Trace is opened and views are populated

Trace is replicated under the new name

Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.

Trace is opened

The first trace editor is simply brought to front.

Correct menu opens (New, Import XML
Analysis, Refresh)

Experiment appears under folder, no traces yet

Correct menu opens (Select, Open , Copy,
Rename, ...)

Select Traces dialog is open and populated w/
traces

Selected traces are imported in the experiment
Experiment is opened and views are populated

Experiment is replicated under the new name

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot

SWTBot

SWTBot
SWTBot
SWTBot
SWTBot

SWTBot

SWTBot

RCPTT
RCPTT

RCPTT

RCPTT
RCPTT
Manual

RCPTT

Numpad-enter doesn't work

Loic Import XML Analysis renamed "Manage XML Analysis"

ProjectView
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6.6
6.7
6.8

6.9

6.10

6.11

7.1
72

73

7.4

7.5

7.6

7.7

78

7.9

7.10

7.11

8.1

8.2

83

8.4

8.5

9.1

9.2

9.3

9.4

Rename experiment
Delete experiment
Open Experiment (Accelerator)

Delete Experiment (Accelerator)
Delete Experiment (open experiment)
Select Traces while Experiment is

open

Experiment Traces
Trace menu
Open trace

Remove trace

Drag and Drop from Traces

Drag and Drop from other Tracing

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop from external (non-
traces)

Drag and Drop of trace with existing
name

Drag and Drop of trace with existing
name (2nd time)
Drag and Drop of trace while

Experiment is open

Propagation
Preparation

Rename propagation
Delete propagation
Propagate trace type 1

Propagate trace type 2

Properties View Synchronization

Trace synchronization

Other trace nodes synchronization

Check trace properties

Check trace properties - experiment

Select the Rename menu and provide a new name.
Open.

Select the Delete menu and confirm deletion
Select an Experiment and press Enter

Select an Experiment and press Delete and confirm
deletion

Open an experiment, select expereiment and press
Delete and confirm deletion

Open an experiment and select an additional trace
(see 6.3)

Select an LTTng trace and open its context menu
Select the Open menu

Open Experiment, select the Remove menu and
confirm removal

D&D a few LTTng traces from the Traces directory

D&D a few LTTng traces from another Tracing
project's Traces folder

D&D a few traces from a non-Tracing project

D&D a few traces from an external file manager

D&D a few files (non-traces) from an external file
manager

1) D&D a trace with name of an existing trace into
experiment folder

2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same
destination folder

Open an experiment and D&D a trace from the
Traces directory (see 7.4)

Copy experiment

In Traces folder, rename a trace showing in both
experiments

In Traces folder, delete a trace showing in both
experiments

Add a trace to 2 experiments. Change its type from
Traces

Add a trace to 2 experiments. Change its type from
one of the experiments

Select a trace under a Traces folder in Project
Explorer view. Repeat with trace under an
Experiment.

Select a Traces folder, Experiments folder, or an
experiment in Project Explorer view.

Open an LTTng kernel trace, click on the trace, check

the new properties view.

Open an experiment which contains LTTng kernel
traces, click on the experiment, check the new
properties view.

Experiment is renamed
Experiment is deleted
Experiment is opened

Experiment is deleted

Experiment is closed and deleted

Experiment is closed and selected traces is
imported to the experiment

Correct menu opens w/ Copy disabled + Remove
Trace is opened and views are populated
Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment with
proper icon. Experiment can be opened.
Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon. Experiment can be
opened.

Selected traces are added to the experiment +
Traces with proper icon (system icon).
Experiment cannot be opened.

Verify that trace is added into the traces folder
and experiment folder with the trace name of the
orignal trace plus a suffix 2

Verify that trace is added into the traces folder
and experiemnt folder with the trace name of the
orignal trace plus a suffix 3

Experiment is closed and selected traces is
imported to the experiment

Selected experiment is replicated

New name is propagated to both experiments
Selected trace is removed from both experiments
All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the selected
trace's "Resource properties" Property and
Value. The "Info > type" property shows the
selected trace category and trace type name.

The Properties view is updated with the selected
item's Property and Value. For Experiment verify
the "type" property is set.

The "Trace properties" should be populated

The "Trace properties" should be populated for
every subtrace

RCPTT
RCPTT
RCPTT
RCPTT

Manual

Manual

RCPTT
Manual

RCPTT

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Numpad-enter doesn't work

Only the properties for the experiment is populated

ProjectView
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10

10.1
10.2
10.3

1

11.1

11.2

113

11.4

11.5

11.6

11.7

11.8

11.9

11.10

11.11

11.12

11.13

12

12.1

122

123

Trace Type Selection

Preparation
Trace properties
Trace filtering

Supplementary Files

Preparation

Create Supplementary File (State
History File) from trace

Trace Context sensitive menu

Delete Supplementary Files Action

Select and delete State History File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files Action

Select and delete State History File

Select and delete multiple State
History files

Delete Trace

Delete Experiment

Delete Experiment Trace
Delete Supplementary Files Action
while trace is open

Link With Editor

Preparation

Select trace/experiment in Editors area

Select opened traces/experiments in
Project Explorer

Import an file with unrecognized trace type (${local}

/traces/import/unrecognized.log)
Select the trace and open the Properties View
Select an experiment and open Select Traces dialog

1) In Project Explorer remove filter for hidden
resources (Coolbar menu > Customize View... >
unselect . * resources)

2) Create Experiment with 2 LTTng CTF traces in it

Open a LTTng CTF trace and wait for indexing to
finish

a) Select trace under Folder Traces and click right
mouse button

b) Redo test: Select trace under Experiment Folder
¢) Redo test: Select Experiment

1) Select trace and click right mouse button

2) Select 'Delete Supplementary Files..."

Select <trace name>/StateHistory.ht file and click on

ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select 'Delete Supplementary Files..."

Select one history file (<trace name>/StateHistory.ht)

and click on 'Ok’

1)Redo 11.2 and 11.6
2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary

File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary

File
b) remove traces under Experiment

Open trace and then redo 11.4
1) In Project Explorer make sure that "Link with

Editor" button is selected
2) Open multiple traces and experiments

Select several traces and experiments one after each

other in Editors area

Select several open traces and experiments one after

each other in Project Explorer

Imported trace appear in Traces with default
icon. File is can be opened by default Editor
(either Eclipse text or system editor depending
on plug-ins installed)

Selected trace type is blank

Untyped trace does not appear in list

Verify that .tracing directory is shown under the
project

Verify that org.eclipse.tracecompass.analysis.os.
linux kernel.ht is created under .tracing/<trace
name>/.

Verify that menu item 'Delete Supplementary
Files..." is shown in the context-sensitve menu
Verify that confirmation dialog box is opend and
<trace name>/StateHistory.ht is listed

Make sure that file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Verify that two StateHistory.ht files are created
under .tracing/<tracel name>/ and .
/tracing/<trace2 name>/ respectively. Also
verify, that supplementatry folder for the
experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and
shows 3 root entries:

<exp name>, <tracel name> and <trace2 name>,
with their respective supplementary files below

Make sure that the selected file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Make sure that both history files are deleted
under .tracing/<tracel name>/ and .
tracing/<trace2 name>/ respectively

Verify that supplementary directory .
tracing/<trace name>/ is deleted.

Verify that supplementary File StateHistory.ht .
tracing/<tracel name>/ and ./tracing/<trace2
name>/ are NOT deleted. Also verify that the
supplementary folder for the experiment .
/tracing/exp_name_exp is deleted.

Verify that supplementary File StateHistory.ht .
tracing/<tracel name>/ and ./tracing/<trace2
name>/ are NOT deleted

Verify that trace is closed and supplementary
files are deleted

Verify that after each selection the corresponding
trace or experiment element is selected in the
Project Explorer

Verify that after each selection the corresponding
trace or experiment is brought to the top in the
Editors area

SWTBot
Manual
SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

Manual

SWTBot tries invalid type for a given valid trace, same thing.

small problem, might be GTK3

ProjectView
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12.4

12.5

12.6
13

13.1

13.2

13.3

134

13.5

13.6

13.7

13.8

13.9

13.10

13.11

13.12

13.13

13.14

13.15

Preparation

Select trace/experiment in Editors area

Select opened traces/experiments in
Project Explorer

Trace Package Export Wizard

Preparation

Open the trace package export wizard

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change format

Change export options, change format
and compression

Finish the wizard

Overwrite

Verify formats

Verify content

1) In Project Explorer make sure that "Link with
Editor" button is not selected

2) Open multiple traces and experiments (if not open)

Select several traces and experiments one after each
other in Editors area

Select several open traces and experiments one after
each other in Project Explorer

1) Import 2 traces that generate supplementay files
(trace2, kernel_vm)

2) Open both traces, wait for the indexing to finish
2) Add bookmarks in the two traces

Click on “File”, “Export...”, “Tracing”, “Trace
Package Export” and click Next

Alternatively, Right-click in Project Explorer on
Project and select "Export", “Tracing”, “Trace
Package Export” and click Next

Alternatively, select multiple traces, right-click and
select "Trace Package Export"

On the left side, select the project in which the traces
were imported. Then on the right side, selected both
traces.

With traces selected, press the Deselect All button.
Then press on the Select All button. Click Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click
Deselect All. Then click Select All again.

1) Click on the Browse button.
2) Select a location on the filesystem
3) Enter the file name export.tar

Unselect the “Compress” checkbox.

Change to Zip format

Change to Tar format then select the Compress
checkbox.

Click Finish

Open the wizard again and select the traces (step
13.2, 13.3). Click Finish.

Open the wizard again and select the traces (step
13.2, 13.3). This time, choose Zip format. Click
Finish.

Open the tar.gz and the zip files in an archive
manager.

Verify that selection in Project Explorer doesn't
change

Verify that Editor in focus is not changed

A wizard should appear with a list of projects
and traces to select. Next button should be
disabled.

Next should be become enabled when the first
trace is selected. If all traces are unselected, the
Next button is disabled.

Next should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to
a lower number.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to
0. The Next button is disabled.

When Select All is clicked, all the tree elements
are selected, the approximate size increases.
When Deselect All is clicked, all the tree
elements are deselected and the approximate size
decreases.

A file chooser dialog comes up. When the
destination file is entered, the “To archive file” is
filed with export.tar.gz. The Finish button should
be enabled.

The name of the archive file changes to export.
tar

The name of the archive file changes to export.
zip

The name of the archive file changes to export.
tar.gz

A progress bar should appear at the bottom the
the dialog and it should disappear upon
completion. The export.tar.gz file should be
created on the file system.

The Archive file name should be remembered
and already filled. A dialog should prompt the
user to overwrite. Answering No should keep the
wizard opened. Answering Yes should re-export
the archive and close the wizard.

The export.zip file should be created on the file
system

In both archives, verify that it contains:

1) A trace folder for each trace containing all the
trace files (excluding supplementary files)

2) A .tracing folder containing all the
supplementary files

3) An export-manifest.xml file listing the trace
files, supplementary files and bookmarks

RCPTT

RCPTT

RCPTT

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

SWTBot

SWTBot

Manual

SWTBot

Manual

Manual

Manual

ProjectView
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13.16
14

14.1

14.2

14.3

14.4

14.5
14.6
14.7

14.8

14.9

14.10

14.11

14.12

14.13
15

15.1

15.2

15.3

154

15.5

Partial selection
Trace Package Import Wizard

Preparation
Open the trace package import wizard

Project Selection

Archive file selection

Deselect/Select All
Trace element selection
Trace sub-element selection

Select/Deselect All

Finish the wizard

Supplementary Files

Bookmarks

Open from bookmark

Overwrite
Time OFffsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog - experiment
selection

Apply time offset dialog - Basic mode

Open the wizard again and select the traces (step
13.2, 13.3). This time, unselect both Supplementary
files subtrees. Click Finish.

Create an empty tracing project. Make sure you have
export.tar.gz available from the Trace Package Export

Wizard (13) test case, which should include
everything including trace files, supplementary files
and export-manifest.xml.

Click on “File”, “Import...”, “Tracing”, “Trace
Package Import” and click Next

Click the Select button. Choose the previously created

project.
1) Click on the Browse button.

2) Browse for export.tar.gz on the file system

With traces selected, press the Deselect All button.
Then press on the Select All button.

Unselect the trace2 element
Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click
Deselect All. Then click Select All again.

Click Finish
Right-click on trace2 in Project Explorer

Open the Bookmarks view

Double click on one of the bookmarks

Open the wizard again (step 13.2) and select the
archive file (step 13.4). Click Finish.

Open Project Explorer view and Properties view.

Create an empty tracing project. Import two different

traces to the project. Open the traces and note their
start time. Close the traces.

Select both trace elements in the Project Explorer
view. Right-click and select Apply Time Offset...

Select the Traces folder element in the Project
Explorer view. Right-click and select Apply Time
Offset...

Create an experiment with both traces. Select the
experiment element in the Project Explorer view.
Right-click and select Apply Time Offset...

Select a trace element in the Project Explorer view.
Right-click and select Apply Time Offset... In the
Offset in seconds column, enter a time with seconds
and decimals. Click OK. Open the trace.

Verify that the exported archive contains:

In both archives, verify that it contains:

1) A Traces folder containing all the trace files
(excluding supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the trace
files and bookmarks

The first page of the wizard should appear
(Choose content to import)

The Into project field gets filled with the selected
project name.

Finish should be become enabled when the first
trace is selected. If all traces are unselected, the
Next button is disabled.

Finish should become disabled after Deselect
All, enabled after Select All.

All elements in the trace tree are unselected.
All elements in the trace tree are unselected.

When Select All is clicked, all the tree elements
are selected. When Deselect All is clicked, all
the tree elements are deselected..

A progress bar should appear at the bottom the
the dialog and it should disappear upon
completion. The two traces should appear under
the project in Project Explorer

Delete Supplementary files appears in the
content menu

Bookmarks appear in the list for the imported
traces

The corresponding trace opens at the
bookmarked event. Bookmarks are displayed in
the event table.

A dialog should prompt the user to overwrite for
each trace. Answering Yes to All should
overwrite without prompting again.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and the
Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and the
Offset in seconds is blank.

The Apply time offset dialog opens in Basic
mode. The Trace name show both traces and the
Offset in seconds is blank.

The timestamps in the trace are all offset by the
entered value. The Properties view shows the
'time offset' with the entered value.

Manual

SWTBot

SWTBot

SWTBot

SWTBot
SWTBot
Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Very fast

ProjectView
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15.6

15.7

15.8

15.9

15.10

15.11

Apply time offset dialog - cumulative
offset

Clear time offset

Apply time offset dialog - Advanced
mode

Apply time offset dialog - Advanced
mode - compute from selection

Apply time offset dialog - Advanced
mode - compute from entered values

Clear time offset with opened traces

Select the same trace element in the Project Explorer
view. Right-click and select Apply Time Offset... In
the Offset in seconds column, enter a time with
seconds and decimals. Click OK. Open the trace.

Select the trace element in the Project Explorer view.
Right-click and select Clear time offset. Click OK to
confirm. Open the trace.

Open one trace and close the other trace. Select both
trace elements in the Project Explorer view. Right-
click and select Apply Time Offset... Choose the
Advanced radio button.

Double-click the second trace to open it. Select an
event in its trace editor. Select the first trace editor.
Select an event in its trace editor. Click the button in
the dialog row of the second trace. Click OK. Open
both traces.

Select the first trace element in the Project Explorer
view. Right-click and select Apply Time Offset...
Choose the Advanced radio button. Double-click the
trace name to open it. Select the Reference time cell
and copy the start time. Select the Target time and
paste the value. Edit both values to different times.
Click the button in the trace row. Click OK. Open the
trace.

Open both traces. Select both trace elements in the
Project Explorer view. Right-click and select Clear
time offset. Click OK to confirm. Open the traces.

The timestamps in the trace are all offset by the
cumulative sum of the previous and current
entered value. The Properties view shows the
‘time offset' with the cumulative value.

The timestamps in the trace are back to their
original values. The Properties view shows the
'time offset' as blank.

The Apply time offset dialog opens and is
switched to Advanced mode. The Trace name
show both traces and the Offset in seconds is
blank. The Reference time for the opened trace is
set to its start time.

Both traces are open. Selecting an event updates
the Reference time for the selected trace, and
updates the Target time for all traces. Pressing
the button computes the Offset in seconds as the
difference between Target time and Reference
time for that row. The trace which has a
computed offset is closed when the OK button is
pressed. After reopening, the two previously
selected events now have the same timestamp.
The Properties view shows the 'time offset' with
the computed value.

The trace is opened. The Reference time is set to
the trace start time. The Reference time and
Target time can be copied, pasted, and edited.
Pressing the button computes the Offset based on
the current time values. The trace is closed with
the OK button is pressed. After reopening, the
timestamps in the trace are offset according to
the computed value. The Properties view shows
the 'time offset' with the computed value.

The opened traces are closed when the OK
button is pressed. After reopening, the
timestamps in the traces are back to their original
values. The Properties view shows the 'time
offset' as blank.

SWTBot

SWTBot

Manual

Manual

Manual

Manual

No button

Cannot edit

GTK 3 broke the apply time offset

ProjectView
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Section
TMF - BookmarksView
Ubuntu 14.10 64 bit

Test Case

Action

Verification

Type

To Do

BookmarksView

2.1

22

2.3

2.4

2.5

2.6

2.7

2.8

29

3.1

32

33

Preparation
Preparation step 1

Trace bookmarks

Show Bookmarks View

Open trace

Add Trace Bookmark

Open Trace Bookmark (1)

Open Trace Bookmark (2)

Open Trace Bookmark (3)

Delete Bookmark (from
table)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Experiment bookmarks

Create and open experiment

Add Experiment Bookmark

Open Experiment Bookmark

1

Open and reset LTTng Kernel perspective

Select Bookmarks view (bottom folder)

Open an LTTng CTF Kernel trace

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the trace #1 and then double-click on bookmark in Bookmarks
view

Select bookmarks icon in event table right-click on icon and select
"Remove Bookmark"

Double-clicking bookmarks icon in event table.

Add a bookmark (see 2.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Create Experiment with 2 LTTng CTF Kernel traces in it and open
experiment

Add a bookmark, by

a) double-clicking on the left margin next to an event

b) right-clicking the margin and select Add bookmark....
¢) using the Edit > Add bookmark... menu.

Enter the bookmark description in dialog box

Scroll within event table so that bookmark is not visible anymore and
then double-click on bookmark in Bookmarks View

LTTng Kernel perspective opens with
correct views.

Bookmaks view is shown

Views are populated. Verify that a
Kernel events editor is opened showing
LTTng Kernel specific columns

Make sure that bookmark icon is shown
on left site of the event row and is added
to the Bookmarks view with relevant
information (i.e. Description entered and
correct trace resource)

Make sure that event with bookmark is
selected and visible in event table

Make sure that correct trace #1 is
brought to top and correct event with
bookmark is selected in events table

Make sure that correct trace #1 is opened
and correct event with bookmark is
selected in events table

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed
from the Bookmarks view

Verify that an Events editor is opened
showing LTTng Kernel specific columns

Make sure that bookmark icon is shown
on left site of the event row and is added
to the Bookmarks view with relevant
information (i.e. Description entered and
correct experiment resource)

Make sure that event with bookmark is
selected and visible in event table

SWTBot

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
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3.4

3.5

3.6

3.7

Open Experiment Bookmark

2

Open Experiment Bookmark

3)

Delete Bookmark (from
table)

Delete Bookmark (from
Bookmarks view)

Open another trace #2 and then double-click on bookmark in
Bookmarks view

Close the experiment #1 and then double-click on bookmark in
Bookmarks view

Select bookmarks icon in Events view, right-click on icon and select
"Remove Bookmark"

Add a bookmark (see 6.4), then select bookmark in Bookmarks view,
right mouse click and select "Delete". Confirm the deletion.

Make sure that correct experiment #1 is
brought to top and correct event with
bookmark is selected in events table

Make sure that correct experiment #1 is
opened and correct event with bookmark
is selected in events table

Make sure that bookmark icon is
removed from event table and
corresponding bookmark is removed
from the Bookmarks view

Make sure that bookmark icon is
removed from event table and
corresponding Bookmark is removed
from the Bookmarks view

Manual

Manual

Manual

Manual

BookmarksView
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Section
TMF - Histogram View

Target: Ubuntu 14.04 64 bit

Step

1

1.1
1.2

2.1

22

2.3

3.1
32

33
3.4

3.5

3.6

3.7

3.8

3.9

3.10

4.1
42

43

44

45

4.6

Test Case
Preparation

Step 1
Step 2

Manage View

Close view

Open view

Resize

Full Trace Histogram
Single selection

Range selection

Drag zoom window

Move zoom window

Set zoom window

Zoom in/out

Arrow keys

Home/End keys

Lost events

Zoom in/out (key)

Time Range Histogram

Single selection
Range selection

Drag zoom window

Zoom in/out

Arrow keys

Home/End keys

Action

Open and reset LTTng Kernel perspective
Open an LTTng trace

Close the Histogram View
Window > Show View > Tracing > Histogram

Resize the Histogram View width-wise

Select timestamp with left-click

Select time range with shift-left-click, shift-left-drag or left-drag
Drag the zoom window left/right with ctrl-left-drag or middle-drag

Move the zoom window with ctrl-left-click or middle-click

Set a new zoom window with right-drag

Zoom in/out with mouse wheel up/down

Move the current event using left/right arrow keys

Press Home/End key

Verification

LTTng Kernel perspective opens with
correct views

Views are populated

Histogram View is removed from
perspective

Histogram View is displayed and re-
populated

Histograms are compressed/decompressed
without loss

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated
Zoom window is dragged, won't go beyond
full range

Zoom window is centered on click, won't go
beyond full range

Zoom window is set, Window Span is
updated, won't go beyond histogram range
Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
full trace range

Selection (blue bar) moves to the
previous/next non-empty bucket

Selection Start/End moves to beginning/end
of trace (i.e. start time of last bucket is
selected)

With a trace containing lost events, click the "Hide lost events" toolbar The lost events (red bars) are toggled on and

icon. Click it again.

Zoom in/out with +/- key

Select timestamp with left-click

Select time range with shift-left-click, shift-left-drag or left-drag

Drag the zoom window left/right with ctrl-left-drag or middle-drag

Zoom in/out with mouse wheel up/down

Move the current event using left/right arrow keys

Press Home/End key

off.

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
full trace range

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated
Zoom window is dragged, won't go beyond
full range

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed
full trace range

Selection (blue bar) moves to the
previous/next non-empty bucket

Selection Start/End moves to beginning/end
of time range (i.e. start time of last bucket is
selected)

Type

SWTBot
SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

To Do

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Comment

Comment

Tested with HistogramDataModelTest

HistogramView

84710

84710
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4.7 Lost events

3.10  Zoom in/out (key)

With a trace containing lost events, click the "Hide lost events" toolbar The lost events (red bars) are toggled on and

icon. Click it again.

Zoom in/out with +/- key

off. Manual

Zoom window is updated, Window Span is
updated, won't go below 2 ns, won't exceed

HistogramView

5.1 Set selection start
52 Set selection end

53 Set selection (linked)
5.4 Set invalid selection start
5.5 Set invalid selection end

Enter a TS within the full range in Selection Start widget

Enter a TS within the full range in Selection End widget

Select the link icon. Enter a TS within the full range in Selection Start
widget

Enter a TS before the full range start in Selection Start widget

Enter a TS after the full range end in Selection End widget

full trace range Manual
Selection Start + blue bars are updated Manual
Selection End + blue bars are updated Manual

Selection Start/End + blue bars are updated Manual
Selection Start + blue bar set to first event Manual
Selection End + blue bar set to last event Manual

6.1 Set window span
6.2 Set large window span
6.3 Set invalid window span

Enter a span in Window Span widget

Enter an invalid span (too large) in Window Span widget

Enter an invalid span (too small, negative, not a number) in Window
Span widget

Both Histograms are updated accordingly Manual
Span set to full range Manual
Span set to previous value Manual

Time Range mouse
7.1 synchronization

Full Trace mouse
7.2 synchronization

Selection synchronization
7.3 (linked)

7.4 External synchronization

Click on the time range histogram. The time of the bucket at the
mouse position is selected.

Click on the full trace histogram. The time of the bucket at the mouse
position is selected.

Select the link icon. Enter a time within the full range in Selection
Start widget

In any other view that supports time synchronization, select a time.

Other views are synchronized to the selected
time Manual

Other views are synchronized to the selected
time Manual

Other views are synchronized to the selected
time Manual

Selection Start/End + blue bars in both
histograms are updated to the selected time Manual

Time Range mouse
8.1 synchronization

Full Trace mouse
8.2 synchronization

Selection Start/End
8.3 synchronization

8.4 External synchronization

Select a time range in the small histogram (shift-left click, left-drag or
shift-left drag).

Select a time range in the full histogram (shift-left click, left-drag,
shift-left drag).

Enter a time within the full range in Selection Start/End widget

In any other view that supports time range synchronization, select a
time range.

Verify that the selected time range shows in
both histograms, and in other views. Manual

Verify that the selected time range shows in

both histograms, and in other views. Manual
Other views are synchronized to the selected

time range Manual
Selection Start/End + blue bars in both

histograms are updated to the selected time

range Manual

Time Range mouse
9.1 synchronization

Full Trace mouse
9.2 synchronization

Window Span
9.3 synchronization

9.4 External synchronization

Select a zoom window in the small histogram (ctrl-left drag, middle-
drag, right-drag, mouse wheel up/down).

Select a zoom window in the full histogram (ctrl-left drag, middle-
click, middle-drag, right-drag, mouse wheel up/down).

Enter a new span in Window Span widget

In any other view that supports range synchronization, select a new
zoom window.

Other views are synchronized to the new
range Manual
Other views are synchronized to the new
range Manual
Other views are synchronized to the new
range Manual

Window Span and both histograms are
updated to the new range Manual

19



4.3.0-TraceCompassTestCases

10

10.1

10.2

10.3

10.4

10.5

10.6
10.7

Multiple Trace
Synchronization

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace (overlap)

Trace coloring
Close all traces

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-

overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-

testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

Select a time and new range

- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-click -> Follow time

updates from other traces

Select a time and new range

Select different trace by clicking its editor tab

With an experiment containing multiple traces opened, click the
"Activate trace coloring" toolbar icon. Click it again.

Close all trace editor tabs

View shows the last opened trace

Selection Start/End, Window Span and both
histograms are updated to selected time and
new range.

View shows the last opened trace

Selection Start/End, Window Span and both
histograms are updated to selected time and
new range.

View is updated to show selected trace.
Selection Start/End, Window Span and both
histograms are set to the newly selected time
and range.

The colors in both Histograms and toggled
on and off. When it is toggled off, the
legend disappears at the bottom and only
one color is used for non-lost events.

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual
Manual

HistogramView
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Section Pass Fail ToDo Comment

TMF - Colors View 6 | 6 | o o

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment
1 Open a test trace a trace is visible in the events editor SWTBot SWTBot Pass
2 Open the colors view the view is visible SWTBot SWTBot Pass
Select a color and a filter, the matching events should update their
3 Select a color and a filter colors (background and foreground) to the new ones SWTBot SWTBot Pass
4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot SWTBot Pass
By clicking on up and down, the order of the displayed colors should
5 Change the color priorities ~ change SWTBot SWTBot Pass
6 Delete all the colors The color filters should disappear. SWTBot SWTBot Pass
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Section
TMF - Filters View

Target: Ubuntu 14.10 64 bit

Step

3.1

4.1

5.1

6.1

7.1

Test Case

Open a trace to be filtered

Open filter view

Create a filter on event type
and timestamp

Apply that filter

Create a filter on the
timestamp oring field values

Apply that filter

Create a filter with equals
node

Apply that filter

Create a filter with matches
node

Apply that filter
Create a filter with contains

node

Apply that filter

Pass
12

Action

Trace is opened

Filter view is opened

The filterview contains a filter on the event type and the timestamp
A subset of the events pass
Create the filter

A subset of the events pass
Create the filter

A subset of the events pass
Create the filter

A subset of the events pass
Create the filter

A subset of the events pass

Verification

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

To Do

[ 12 [ o |4

FiltersView
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Section Pass Fail
TMF - Sequence Diagram 37

Target: Ubuntu 16.04 64 bit

Step

1

1.1

12

1.3

Test Case Action Verification

Preparation
1) Download traces.zip (if necessary) and unzip
into a local directory ${local}
2 )Use traces simple-server-thread1 and simple-
server-thread2 under traces/import/ for test cases

below

LTTng Kernel perspective opens with
correct views:
Project Explorer, Control, Control Flow,
Resources, Statistics, Histogram,

Open perspective Open and reset LTTng Kernel perspective Properties, Bookmarks

Open TMF Sequence Use menu Window — Show View — Other ... — Tracing  Verify that 'Sequence Diagram' view is

Diagram View — Sequence Diagram shown

1) Create Tracing Project
2) Create Experiment (SeqExp)
3) Import 2 traces simple-server-threadl and simple-server- Verify that sequence diagram was loaded.

thread2 The interaction show the signal numbers
4) Add these 2 traces to experiment (Note that trace doesn't contain strings for
Create and open experiment  6) Open (double-click on) the experiment the interactions. A special parser would be
with sequence diagram data necessary to map signal number to trace)
Manage View
Close view Close Sequence Diagram view Sequence Diagram View is removed from p
Open view when 1) Close 'Sequence Diagram' View
experiment/traces is already ~ 2) load sequence diagram experiment Verify that sequence diagram was loaded.
loaded 3) Open Sequence Diagram view Verify that all 17 pages are loaded.
Tooltip
Verify that tooltip appears with content
1) Goto to first page (no selection of any interaction or with interaction name and time stamp
Hover over interaction lifeline) 2) Hover over first interaction (arrow or number) (10000 14:58:00.740995147)
Verify that tooltip appears with content
with interaction names and time stamp
1) Goto to first page delta between selected interaction and
Hover over interaction after ~ 2) select first interaction interaction that was hovered over (10001
selection 3) Hover over 3rd interaction — 10000 delta: 000.000 157 023)

Verify that tooltip appears with delta and

graph to show where delta is in relation to
Hover over time compression Hover over first element in time compression bar on the left current configured min max values. (delta:
bar of the view 000.000 3 480)

View Synchronization
Verify that interaction is highlighted in
'Sequence Diagram' view. Verify that in
the events table the corresponding event is
Selection of interaction Select an interaction in the 'Sequence Diagram' selected. Verify that time stamps matches
Selection of event in events  Select an sequence diagram event in the events table (type ~ Verify that corresponding interaction is
table SEND or RECEIVE) selected in the 'Sequence Diagram' view

Verify that the content of the 'Sequence
diagram' changes and the interactions are

Selection of new time range  Change time range in 'Histogram View'. part of the new window range

View Actions

ToDo Comment

[ 2 | o o

Type Comment

Note: Ul tests are not SWTBot, but JUnit tests. Tests are
triggered programmatically right below the dialogs level

SWTBot Pass

SWTBot Pass

Manual Pass

Manual Pass

Manual Pass  Difficult to get the numb of pages

Tooltip backgound is very dark and text is hard to read
on Ubuntu 14.10, 16.10 with default theme
Manual Pass  https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523.

Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

SequenceDiagram
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5.1

5.2

53

5.4

5.5

5.6

5.7

5.8

5.9

5.10

5.11

5.12

5.13

5.14

Test page navigation

Test menu item 'Pages...'

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Reset zoom

Use buttons and menu items 'Go to next page', 'Go to
previous page', 'Go to last page' and 'Go to first page' to
navigate through trace. Use also menu item 'Pages..." to jump
to specific page

1) Select menu item 'Pages..."
2) In text box type “9”
3) Click on 'OK'

Goto to page 1 —

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1 —

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse

2) open find dialog

1) Select 'Sequence Diagram' view
2) press CTRL+f

Goto to page 1 —

1) Use menu item 'Hide Patterns..."

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.¥03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 —

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

1) Apply one filter

2) Use menu item 'Hide Patterns...'

3) deselect filter

4) click 'Ok’

1) Restart eclipse

2) open hide dialog

1) Use button and menu item for zoom-in to activate
zooming in

2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to
selection mode

2) select an interaction

1) Use button and menu item for zoom-out to activate
zooming out

2) click into sequence diagram view

1) Use button and menu item for 'Reset zoom factor' to reset
the zoom level

Verify that different time ranges are
selected when changing page by looking
at Histogram View. Histogram View
window will show the start of the page.
Note that there are 10000 interactions per
page. In this traces there are in total
160032 interactions. Verify that last page
has 32 interactions between 2 lifelines.

Verify that a dialog box will show. Verify
that for this trace it shows 'Total: 17 pages
is shown” and the current page is
displayed in the text box. After step 3)
verify that page where changed to page 9.
For this trace page 9 is the page with 3
lifelines.

After 4) verify that interaction 10000
(playerl — master) is selected. After 5)
verify that interaction 10100 (master —
playerl) is selected. After 6) verify that
10000 (player2 — master) is selected.
After 7) verify that interaction 10100
(master — player2). After 8 nothing else
will be found

After 4) verify that lifeline with name
player2 is selected (page 9 with 3
lifelines). After 5) player2 is selected on
page 10

Verify that previous used find criteria are
still in the list

Verify that find dialog opens

After 5) verify that Interactions with name
10003 and 10103 are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are
shown

Verify that previous used hide criteria are
still in the list

Verify that 'Sequence Diagram' view
zooms in. Note that no selection is
possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view
zoom out. Note that no selection is
possible.

Verify that 'Sequence Diagram' view goes
back to default zoom

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

| agree with JC, It reaches the right pages but the
selection does not highlight anything when the find box is
still opened. It only highlight the lifeline when we close
the find dialog.

Bernd: It supposed to highlight the lifeline on the correct
page. So, test is successful. JC: The selection highlight
the lifeline but it is difficult to see.

Hung: I have changed pres CTRL+F to press CTRL+f

SequenceDiagram
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5.15

5.16

5.17

5.18

5.19

520

5.21

5.22

523

524

5.25

527

Configure min/max

Configure min/max (default)

Show node end

Show node start

Show node end short-cut

Show node start short-cut

Scroll down short cut

Scroll up short cut

Overview feature

Print

Remove filter (Bug 391714)

Time Sync. without
interactions (Bug 391716)

1) Select menu item 'Configure Min Max'

2) Change min to 100 and max to 2000 (keep scale and
precision)

3) press 'Ok’

After changing min and max
1) select menu 'Configure Min Max'
2) press 'Default’ 3) press 'Ok’

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Use menu item Navigation — Show node end

Goto to page 1 —

1) Resize view so that the beginning of the interactions are
not shown

2) select on interaction

3) Use menu item Navigation — Show node start

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Press SHIFT+ALT+END

Goto to page 1 —

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Press SHIFT+ALT+HOME

Press SHIFT+ALT+ARROW_DOWN

Press SHIFT+ALT+ARROW_UP

Goto page 9 — Keep pressing + icon at the lowest right
corner of the view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to
print

1) Create Ifilter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open filter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

1) Open trace without any sequence diagram information
2) Open SD view if necessary

3) Open Error Log view if necessary

4) change time range in Histogram view

5) Change time current selected time in Histogram View

After 1) verify that a dialog box shows
with default values. After 3) verify that
time compression bar changes some
colors. It will show more deeper red
because the max value is lower.

After step 2) the default values are shown.
After step 3) the time compression bar
will change colors. Note that the default
values are computed based on all deltas of
2 consecutive interactions.

Verify that end lifeline of the interaction
(the arrow) is shown

Verify that start lifeline of the interaction
is shown

Verify that end lifeline of the interaction
(the arrow) is shown

Verify that start lifeline of the interaction
is shown

Verify that within a page the display
scrolls down per view size

Verify that within a page the display
scrolls up per view size

Verify that it's possible to navigate
through a page of the sequence diagram
view

Verify that it is possible to print

Verify that no exceptions occurred and
after 5) no filter are listed

Make sure that no exceptions occurred

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

The shortcut is not working when the mouse is hovering
the interaction as seen in the previous version 4.0.0

The shortcut is not working when the mouse is hovering
the interaction as seen in the previous version 4.0.0

Key combination on Ubuntu 12.04 is used for something
else. This can be disabled using the combiz-settings-
manager (http://askubuntu.com/questions/171489/how-
to-unbind-shift-alt-up-shortkey-in-12-04)

After disabling this combination this test case passes

On Ubuntu 14.04, 14.10, this is not an issue, by default
the keys are not mapped.

On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is a
visible empty space that is clickable in its place. Clicking
on it brings up the overview box which has a reasonable
size but movement is still hectic.

Bug 436442

The dialog is confusing on Ubuntu. The "from pages"
option do not update directly the values you enter

GTK 3 problem ?

Works on windows (including CTRL+P) Pass on 16.04 and 16.10.

SequenceDiagram

... could it be cups giving you a hard time?
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Target:

Step

1

1.1

2

w

E-Y

4.1

42

43
44
45

v

(-}

Section
TMF - EventsEditor

Test Case

Preparation

Preparation step 1

Trace bookmarks

Experiment bookmarks

Filter

Filter

Cancel filter

Un-filter
Filter & Search
Search & Filter

Time Synchronization
Mouse synchronization
Key synchronization
Search synchronization
External synchronization
Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

Search synchronization

External synchronization

Pass

Action

Open and reset LTTng Kernel perspective

Moved to sheet "BookmarksView"

Moved to sheet "BookmarksView"

In the header row, enter some regex and press Ctrl+Enter

In the header row, enter some regex and press Ctrl+Enter, then quickly

press ESC before filtering is done

In the header bar, click the icon to delete a filter

In the filter bar, enter some regex; likewise in the search bar
In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp, PageDown,

Home, End

In the search bar, enter some regex, then search again with Enter/Shift-

Enter

In any other view that supports time synchronization, select a time.
Select an event with left button, press shift key and click select

another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp, PageDown,

Home, End

In the search bar, enter some regex, then search again with Enter/Shift-

Enter

In any other view that supports time synchronization, select a time.
The selected event in the editor is updated. Then give focus back to the

editor.

Fail

Verification

LTTng Kernel perspective opens with correct views.

Only events matching regex are displayed. Top and
bottom filter status rows update while filtering is
ongoing. When filtering is done, status rows show
number of matching events.

Only some events matching regex are displayed. Status
rows show partial number of matching events, with
different 'stop' icon.

All events are displayed. Selected event remains
selected and visible. Status rows are removed.

Events are filtered and highlighted accordingly
Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

The first event at or following the selected time is
selected and visible.

Range of events are highlighted. Selection range is
updated in other views that support range selection

Verify that an editor is opened showing LTTng Kernel
specific columns. Views are updated with the new
trace.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected

event's Property and Value. Timestamp and Content
are expandable.

Type

To Do

EventsEditor

Comment

| 11 [ o fa

SWTBot

SWTBot

Manual

SWTBot
SWTBot
SWTBot

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

GTK 3 filter text doesn't work, but it workswell with GTK-3.16.6

When the search wrap the table is losing focus, but not losing the focus at
the same time and the property view is not updated until you do an other

enter or shift-enter
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7

7.1

72

7.3

7.4

8.1

8.2

8.3

9.1

8.2

Source Code / Model
Lookup

Preparation

Open call site

Open call site (no source
code)

Open model URL

Export to text

Export CTF trace

Export Other Trace

Copy to clipboard

Swap Columns and
Change Fonts

Swap columns in events table

Change fonts

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and traces/callsite.zip

to your local disk.

3) Import demo C project to the Eclipse workspace of zip

file c_project_callsite.zip

4) Import the test trace of zip Ffile callsite.zip to a tracing

project.

Select trace type "Generic CTF Trace" and open the trace

1) select event in table
2) click right mouse button
3) select "Open Source Code" menu item

1) Close source code project

2) select event in table

3) click right mouse button

4) select "Open Source Code" menu item

1) select event in table (e.g. 1st event)
2) click right mouse button
3) select "Open Model Element" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item

4) Enter a file name and location

5) Press OK

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Copy to Clipboard" menu item
4) Paste it in a text file

1) Open a trace
2) Drag a column

1) Open the preferences
2) select new font for trace types

3) press apply
4) verify that the font changed

Verify that correct source code file and line number is
opened Manual

Since the source code is not available the no source
code file is opened. Instead a error dialog is opened
(with title "FileNotFoundException") Manual

Since the model is not available the model element is
not shown. Instead a error dialog is opened (with title
"FileNotFoundException") Manual

Make sure that a progress monitor dialog is opened

during the export. After finishing make sure that the

text file exists and it contains the events stored in the

file. Verify that the columns are printed as shown in the

events table and that they are separated by tab

character. SWTBot no progress monitor dialog, only a job

Make sure that a progress monitor dialog is opened

during the export. After finishing make sure that the

text file exists and it contains the events stored in the

file. Verify that the columns are printed as shown in the

events table and that they are separated by tab

character. Manual

Verify that the columns are printed as shown in the
events table and that they are separated by tab

character. ~ SWTBot
Covered by SWTBot tests SWTBot
Covered by SWTBot tests SWTBot

EventsEditor
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83

Reset fonts

1) Open the preferences

2) Reset the font settings

3) Press apply

4) verify that the font changed

Covered by SWTBot tests

SWTBot

EventsEditor
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Section
TMF - Statistics View

Target: Ubuntu 14.04 64 bit

Step

1

1.3

2.1

2.2

2.3

3.1

3.2

4.1

4.2

5

Test Case
Preparation
Preparation

Open Perspective

Open TMF Statistics View

Open experiment
Manage View
Delete view

Open view

Open view when
experiment/trace is already
loaded

Other

Build of statistic index

Persistence of statistics
Range Synchronization

External synchronization
(full)

External synchronization
(range)

Multiple Trace
Synchronization

Action

Download traces simple-server-thread1 and simple-server-

thread1 from traces/import/

Open and reset LTTng Kernel perspective
Use menu Window — Show View — Other ... — Tracing —

Statistics

1) Create Tracing Project
2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-server-thread2
4) Select trace type "Generic CTF Trace"

5) Add these 2 traces to experiment

Close the 'Statistics' View

Use menu Window — Show View — Tracing — Statistics

1) Close 'Statistics View' 2) load trace above trace 3) Open 'Statistics'

view

Open trace

Open same trace multiple times after indexing of trace was finished

the first time

In any other view that supports range synchronization, select the full

range of the trace.

In any other view that supports range synchronization, select a new

range.

Verification

LTTng Kernel perspective opens
with correct views

Verify that 'Statistics' view is
shown

Verify that statistics are shown per
trace and per event type. Each
trace has 80021 events. Verify that
event types
ENTER/RETURN/SEND/RECEI
VE/INFO/after fork child are
counted.

Statistics' view is removed from
perspective

Statistics' view View is displayed
and re-populated

Verify that statistics are shown per
trace and per event type. Each
trace has 80021 events. Verify that
event types
ENTER/RETURN/SEND/RECEI
VE/INFO/after_fork_child are
counted

Verify that 'Statistics' view is
populated gradually during
indexation

Verify that when opening the trace
the x-times (x > 1), that the
statistics appear right away
without parsing the trace again

Events in 'Events in selection' is
updated and equals 'Events total'
values

Events in 'Events in selection' is
updated according to new range

To Do

Type

SWTBot

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

StatisticsView

Comment

Comment

Path is actually Window -> Show view -> Tracing -> Statistics
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52

53

5.4

5.5

5.6
5.7

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and
range (overlap)

Select other trace (overlap)
Close all traces

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

In any other view that supports range synchronization, select a new
range

Select different trace by clicking its Events editor tab

Open multiple traces that overlap in time

In any other view that supports range synchronization, select a new
range

Select different trace by clicking its Events editor tab
Close all Events editor tabs

View shows the last opened trace

Events in 'Events in selection' is
updated according to new range
View is updated to show selected
trace. 'Events in selection' is
updated according to the selected
trace's previously selected range.

View shows the last opened trace
Events in selection' is updated
according to new range

View is updated to show selected
trace. 'Events in selection' is
updated according to the newly
selected time and range.

View is cleared.

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

StatisticsView

Verified in Aug. 20-2018 at 16:07PM. Patrick: The pie
chart doesn't know from which trace the event comes
from. Maybe we could skip events in the tree that have
zero count though? Agree with Patrick, what we should
do?
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Section
TMF - Time Chart View

Target: Ubuntu 16.04 64 bit

Step

1

1.1
12

N

2.1

2.8
2.9

w

4

Test Case

Preparation

Preparation step 1

Preparation step 2

Trace handling

Open trace

Open other trace

Open experiment

Select other trace

Select other trace (external)
Close view

Open view

Close trace/experiment
Close last trace

Time Synchronization

Mouse synchronization
(single time)

Mouse synchronization (time Shift-left-click or left-drag on the time chart. The selected time range

range)

External synchronization
(single time)
External synchronization
(time range)

Zoom Range
Synchronization

Pass

Action

Open and reset LTTng Kernel perspective
Show Time Chart View

Open an LTTng CTF Kernel trace #1

Open an LTTng CTF Kernel trace #2

Open an experiment

Select trace #1 by clicking its trace entry in Time Chart view

Select trace #2 by clicking its editor tab

Close the Time Chart view

Show Time Chart view

Close trace #2 editor tab. Repeat with experiment editor tab.
Close trace #1 editor tab

Left-click on the time chart. The selected time line is updated.

is updated.

In event table, select an event.

In event table, select an event range with shift-left-click.

Fail

Verification

LTTng Kernel perspective opens with
correct views.

Time Chart view is shown

Trace #1 entry added to Time Chart
view. Trace #1 is selected entry. Range
of view is full trace range.

Trace #2 entry added to Time Chart
view. Trace #2 is selected entry. Range
of view is union of full trace ranges.

Experiment entry added to Time Chart
view. Experiment is selected entry.
Range of view is union of full trace
ranges.

Trace #1 is selected entry. View range
does not change. Trace #1 editor tab is
brought to top.

Trace #2 is selected entry. View range
does not change.

Time Chart view is removed from
tracing view

Time Chart view is displayed and re-
populated with opened traces data

Trace entry is removed from Time Chart
view. Range is view is union of
remaining full trace ranges.

View is cleared.

Other views are synchronized to the
selected time. Event at or following the
selected time is selected in the event
table.

Other views are synchronized to the
selected range. Event at or following the
selected time is selected in the event
table.

Selected time line is updated to the
event time. If necessary, range is
updated to show selected time.

Selected time line is updated to the time
range.

Type To Do
1 0

Type
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
0

Comment

TimeChartView
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4.1

42

4.3

44

4.5

5.1
5.2

5.3
5.4

5.5
5.6

Mouse wheel
synchronization

Mouse drag zoom
synchronization

Mouse drag move
synchronization

Mouse full range
synchronization

External synchronization

.Event Table

Synchronization

Search synchronization
Search cleared

Filter synchronization
Filter cleared

Bookmark synchronization
Bookmark cleared

Zoom in/out with mouse wheel while holding Ctrl.
Drag zoom with right-button on time chart.
Drag move with ctrl-left or middle button on time chart.

Double-click with left button on time chart's time scale.
In any other view that supports range synchronization, select a new

zoom range.

Enter a search regex in event table
Clear the search regex in event table

Enter a filter regex in event table
Clear the filter regex in event table

Add a bookmark in event table
Remove the bookmark in event table

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the
new range

Other views are synchronized to the full
range

View range is updated to the new range

Matching events are marked in time
chart

Marks are removed in time chart

Non-matching events are removed from
time chart

All events are shown in time chart

Bookmarked event is marked in time
chart

Mark is removed in time chart

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual
Manual

Manual
Manual

TimeChartView
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Section
TMEF - Custom Parsers
Target: Linux 64

Step Test Case

0 Prerequisites

0.1  Get custom parser definition and logs

-

View management

1.1 Open perspective

1.2 Import custom parser definitions

1.3 Import custom traces

2 Custom parser management

Pass

Action

Find text and XML parser definitions in
Traces.zip/traces/customParsers and logs
in /import

Open and reset Tracing perspective, and open
Time Chart view

Create a tracing project, open Manage
Custom Parsers dialog and import text
and XML custom parser definitions

Create a tracing project and import a text
and XML custom trace

Open Manage Custom Parsers dialog in

2.1 Open Manage Custom Parsers dialog Traces folder context menu

2.2  New (text)
2.3 Edit (text)

2.4  Export (text)
2.5 Delete (text)

2.6  Import (text)

2.7 New (XML)
2.8 Edit (XML)

2.9  Export (XML)
2.10 Delete (XML)

211  Import (XML)

3 Custom parser trace handling

Select "Text" radio button, click New...
button, enter Trace type, change stuff,
click Next, click Finish

Select custom parser, click Edit..., change
stuff, click Next, click Finish

Select custom parser, click Export, enter
name, click Save

Select custom parser, click Delete

Click Import, find custom parser definition,
click Open

Select "XML" radio button, click New...
button, enter Log Type, write an xml log in
the input,
<a><b><c>1</c><d>1</d></b><b><c>2</
c><d>1</d></b></a> then click on the
"feeling lucky" button. Set b to log entry,
set ¢ to timestamp logged and d to
message logged, set timestamp format to
ss in both text boxes, click Next, click
Finish

Select custom parser, click Edit..., change
stuff, click Next, click Finish

Select custom parser, click Export, enter
name, click Save

Select custom parser, click Delete

Click Import, find custom parser definition,
click Open

Fail

Verification

Time Chart view opens.

Custom parsers imported (TmfGeneric,
Custom XML Log)

Traces imported in Traces folder of project
(ExampleCustomTxt.log,
ExampleCustomXml.xml) and have their trace
type auto-selected.

Dialog opens.

Custom parser appears in list.

Previously entered data appears, can be
edited.

Exported custom parser stored in file system.
Custom parser is deleted.

Imported custom parser appears in list.

Custom parser appears in list.

Previously entered data appears, can be
edited.

Exported custom parser stored in file system.
Custom parser is deleted.

Imported custom parser appears in list.

Type To Do
12 0

Type
SWTBot Pass
RCPTT Pass
RCPTT Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
RCPTT Pass
SWTBot Pass
RCPTT Pass
Manual Pass
Manual Pass
Manual Pass
SWTBot Pass
Manual Pass

Comment
2

Comment

Custom Parsers
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3.1

3.2
3.3

3.4

3.5

3.6
3.7

3.8

41

4.2

4.3

4.4

4.5

4.6

Select trace type (text)

Open trace (text)
Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table

Select Event (Bug 457852)

Select Event using arrow keys

(457852)

Hide Raw viewer

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML
> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace

2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide
Table"

Right-click in raw viewer and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw"

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.
Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table is
shown

RCPTT

Manual

Manual

Manual

RCPTT

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Custom Parsers

Or select the trace and verify the trace type in the
properties view

should this be in events editor?
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Section Pass Fail Type ToDo_ Comment

T - State System Explorer
Target: Ubuntu 14,04 64 bit

Test Case Action

1 Preparation
Open TMF State System Explorer Use menu Window —» Show View —» Track
View

X ate System Explorer Verfy that ‘Stat System Explorer view is shown SWTBot Pass s
2 Manage View
St System Expoe view s romovd om
21 Delet view Closethe State System Explorer View persn SWTBot Pass sann
Use e Window — S Vi - Tcing S, Syt Exlre view i dplayd nd -
22 Openview ~ State System Explorer populatc SWIBot Pass i
Verfy that view is populated with kernel state system
(o.c.analysis.os linux kernel) and statistcs site
23 OpenTrace Open an LTTog Kerel Trace systems (o.e.Ltmf statistics*) of opened race SWTBot [ T —— s
1) Clos Sate Syt Explore View
Open view when trce s already ) Load LT Tng rac Verfy that view is populated withstate systems from
24 loaded 3)OpenStte System Explore view nace SWTBot |11 [————— s
e o up it "Ou of S"w M}w,h 3
Works now, e
Verify that view s populid ith l ke st Beuso i th epratin e, e | e e i
system and sttiste s of apene e £ e sommons e 1 st s e, (Only o s i e
Open Experiment Open Experiment with 2 o more LTTrg races cxpeiment (epued by ey RCPTT |1 ir—
View is updated 1o show selected trace, Sate values,
Selectdiferent race by clicking s Events  star i and end time are UMMMVM oihe
27 Sclectother race edior ab slected trace's previously selected rang Manual Pass
Verfy that viewis pow.m with state systems from
Restart Restar Eclipse nace Manoal Pass
Close fom  Verify that sa view i cleared afer
27 Closeallraces the editr ab closing the lst race Manual Pass
3 Timestamp / Time Range Selection
Select time in another view (e Histogram
s Verfy that sate valuc . Manl Pass
Verfy that only th start o the range s taken in
s e jew that time ofthe range
32 Seleettime range supports ime synchronization Should not affet the displayed valucs) Manual Pass
4 Displaying of Changed Values
Select many different timestamps one aferthe  Atrbutes whose valuc changed i the lasttimestamp.
41 Highlighing of changed values other sccction should b highlighted in yellow: Manoal Pass
“Only Display Changes at Selected  Enable the “Only Display Changes at Selected
Timestamp” option with event  Timestamp” opion with the oolbar bution.  Verify tha any the state values that changed because.
42 selection Seleet diferent Events from the Event Table.  of tha event are displayed Manual Pass
bl e
Timestamp"” option. Slect P
“Only Display Changes ar Sel cor rmvmmm oSt changes (o skl
Timesamy” it imesamp singh prviousht buons nthe onrl Vit ly st vt changd
cton P v, timestamp are disply: Manual Pass Chamel e Evenype Contens » pio o
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Section
TMEF - Flame Chart View
Target: Ubuntu 16.04 64 bit (ELX)

Test Case

0 Download the test resources
1 Preparation

1.1 Open TMF Flame Chart View

1.2 Import generic trace

1.3 Import cyg-profile trace
1.4 Import cyg-profile-fast trace

2 Manage View
2.1 Delete view

2.2 Open view

23 Open Trace

Open view when trace is already

2.4 loaded

2.5  Open Experiment
2.7  Select other trace
2.6 Restart

2.7  Close all traces

3 Navigation

3.1 Select time

3.2 Select Previous/Next Event
3.3 Zoom to function (table)

3.4  Zoom to function (time graph)

3.5  Go to first event in trace

Action
Download this

Use menu Window — Show View — Other ... —
Tracing — Flame Chart

Import a trace that does not have any call stack
information, like a standard kernel trace

Import the trace in the "trace" directory of the
downloaded zip

Import a trace in the "trace-fast" directory of the
downloaded zip

Close the Flame Chart View

Use menu Window — Show View — Other ... —
Tracing — Flame Chart

Open "trace(-fast)" trace

1) Close 'Flame Chart' view

2) Open "glxgears-cyg-profile(-fast)" trace located
in the git in ctf test

3) Open 'Flame Chart' view

Open Experiment with 2 or more Flame Chart
traces.
(You can use both traces)

Select different trace by clicking its Events editor
tab

Restart Eclipse with Flame Chart trace opened

Close traces and experiment one by one from the
editor tab

Click on random time in the time graph pane

Click Previous/Next Event button

Double-click on a function in the table pane

Double-click on a function (interval) in the time
graph pane

Go to events editor, press home

Verification

Verify that 'Flame Chart' view is shown

Verify that nothing is shown in the view, except
“Stack info not available (<tracename>)”

Verify that the Flame Chart View is populated with
some callstack information.

Verify that the Flame Chart View is populated with
some callstack information.

Flame Chart' view is removed from perspective

Flame Chart' view is displayed and re-populated

Verify that view is populated with call stack
information

Verify that view is populated with call stack
information

Verify that view is populated with all call stack
information (separated by trace).

View is updated to show selected trace.

Verify that view is populated with call stack from
trace

Verify that Flame Chart view is cleared after closing

the last trace

Selected time line is updated. Table is updated to show
the full stack information at the selected time. Selected

time is updated in other views.

Previous or next call stack change is selected and
corresponding active function and stack depth is
selected. Table is updated to show the full stack
information at the selected time. Selected time is
updated in other views.

Time range is updated to the full duration of the
selected function

Time range is updated to the full duration of the
selected function

the Flame Chart view is updated

SWTBot

Manual

SWTBot

SWTBot

Manual

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Flame Chart View

Comment

Comment

Path is actually Window -> Show view -> Tracing -> Flame Chart

Verified in Aug. 16-2018 at 12:08PM

Verified in Aug. 16-2018 at 12:08PM

See comment 1.1. about the path

Fixed in https:/git.eclipse.org/t/#/c/80177/1 Hung:Verified in
Aug. 16-2018 at 13:39PM
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4 . Synchronization

4.1  Time synchronization
4.2 Event synchronization
4.3 Time range synchronization

5 vFunction name import - Text file

5.1 Invalid text file import

5.2 Valid text file import

6 Function name import - CDT

6.1 Binary import

6.2  Binary import Ittng 2.8+

Select a random time in another view

Select a call stack-impacting event (function
entry/exit) in events table

Select a new time range in Histogram view.

Open 'trace' from Fibonacci.zip. Click the "Select a
mapping file" button in the view and click
"Browse" to select a random .txt file that does not
contain any debugging info.

Import a file "fibonacci.symbols"

Click the "Select a binary file" button in the view
and click "Browse" to select the fibonacci
executable (fibonacci).

Open an Ittng 2.8+ trace with the executable
present

Selected time line is updated. Table is updated to show
the full stack information at the selected time. If
selected time is outside current range, time range is
updated to include it.

In addition to updating the selected time, the active
function at the event time is selected. Vertical scroll
bar is updated if necessary.

Time range is updated.

The function addresses do not change.

The view now displays function names instead of
function addresses (both in the timegraph and the call
stack areas).

The view now displays the function names for both
traces

The view now displays the function names for the
trace

SWTBot

SWTBot
SWTBot

Manual

SWTBot

Manual

Manual

Flame Chart View

N/A

The vertical scroll bar is not updated(Sonia: only when you select
a rendom time in the histogram view).If you select an event (in
another view)before the start of the calls, the vertical scroll bar
goes down.

Verified in Aug. 16-2018 at 14:46PM

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.

France : I am not sure what to do here Sonia : The bug is resolved
, you can specify a mapping file for each trace if you have a
multiple traces in one experiment.

Sonia :you have to specify the binary file for each trace.The view
won't display the function names for the both traces if we select
the fibonacci executable for a trace in an experiment with multiple
traces. Hung:Verified in Aug. 16-2018 at 14:47PM

Verified in Aug. 16-2018 at 14:468PM
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Section
GDB Tracing

Target: Ubuntu 14.04 64 bit

Step

1
1.1
1.2

N

2.1
22
23

3.1
32
33

FS

4.1

42
43

5.1

6.2
6.3

~

7.1
7.2
7.3
7.4
7.5
7.6

GDB 7.11.1
Test Case

Preparation
Step 1
Step 2

Project Creation
New Project Wizard
Create project
Project structure

Traces Folder

Traces Folder menu
Trace Import Wizard
Import traces

Trace Configuration
Project/executable selection
Select Trace Executable
Open configured trace
Source Code Lookup
Select event

Select another event

Events Table Navigation

Arrow keys

Scrolling
PgUp/PgDn

Home/End

Events Searching & Filtering
Search

Navigation

Un-search

Filter

Filter & Search

Un-filter

Pass

Eclipse CPP EPP RC2
Action

Open and reset the GDB Trace perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specity a project name and finish
Close and open the new Tracing project

Select the Traces folder and open its context menu
Select Import Trace
Select a GDB Trace from samples directory and finish

Double-click on an un-configured trace

1) Right mouse click on trace
2) Select menu item "Select Trace Executable"
3) Fill in the proper values in dialog and finish

Double-click on a configured trace

With mouse select an event in events table

redo 5.1

Update the current event using up/down keys within window

Fail

Verification

GDB Trace perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer
Project contains the Traces folder

Correct menu opens (Open Trace, Import, New
Folder, ...)

Trace Import Wizard appears
Imported traces appear in Folders with proper icon

Verify that an Error Dialog opens that notfiies the
user to select the trace executable

Trace is configured (4.3 is successful, when 4.2 was
successful)

Trace is opened, events table and views are populated

The corresponding source code location is selected in
the source code file.

The corresponding source code location is selected in
the source code file.

Each keystroke modifies the selected event and the
corresponding source code location is selected in the
source code file.

Table is refreshed to display new current event and
the corresponding source code location is selected in

Update the current event using up/down keys outside window  the source code file

Update the current event using PgUp/PgDn keys

Update the current event using Home/End keys

In the search bar, enter some RE

Navigate through highlighted events using Enter/Shift-Enter
In the search bar, clear the RE

In the search bar, enter some RE and press Ctrl+Enter

In the filter bar, enter some RE; likewise in the search bar
In the filter header, remove the filter

Table is scrolled accordingly

Table jumps from first to last event and the
corresponding source code location is selected in the
source code file

Events corresponding to the RE are highlighted
Next/previous highlighted event selected accordingly
Events are displayed normally

Only events matching RE are displayed

Events are filtered and highlighted accordingly
Events are displayed normally

Type

Type

Manual
Manual

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual
Manual
Manual
Manual
Manual
Manual

To Do

Pass
Pass

Pass
Pass
Pass

Pass
Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass
Pass
Pass
Pass
Pass
Pass

Comment

| s [ o Jo

Comment

GDBTracing
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GDBTracing

8.1 Synch from Events View
8.2 Synch from Trace Control

Click on an event in the Events View
Go up/down from the Trace Control View

Trace Control View is updated; Debug View is
updated

Events View is updated accordingly

Manual
Manual
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Section
LTTng 2.0 - CPU Analysis

Target: Ubuntu 16.04 64 bit (ELX)

Step

0

0.1

1.1

1.2

1.5

2.1

22
2.3

24
25

2.6

3.1

3.2

Test Case

Prerequisites

Import traces
Project View

Check analysis can
execute

Verify help message when
applicable

Check analysis for another
trace type

View Management

Populate analysis's view

Open view
Close trace

Open trace
Close view

Re-open view
View selection

Select an entry

Select another entry
Mouse handling

Type

To Do

Action Verification Type

Import LTTng Kernel traces in
Tracing project

In the project explorer and expand a "CPU usage" analysis is present
LTTng Kernel trace and it's not crossed out Manual

In the project explorer, open and
expand the LTTng kernel trace, right-

click the CPU usage analysis and A generic help message appears

select Help with the name of the analysis Manual
In the project explorer, expand a non- "CPU usage" analysis is not

LTTng Kernel trace present Manual

Open an LTTng kernel trace and

expand the "CPU usage" analysis in "CPU Usage" View appears under

the project explorer the analysis Manual
The CPU usage Usage view opens

and triggers the cpu analysis. After
Double-click the CPU usage View the analysis, both tree viewer and

under the CPU usage analysis Xy charts are populated. SWTBot
Close the trace The CPU Usage view is emptied. Manual
With the view already opened, open

the trace The CPU Usage view is populated. SWTBot
Close the CPU Usage view The view is closed. Manual
Double-click the CPU Usage view

under the CPU usage analysis in The view opens and is

project explorer. automatically populated. SWTBot

A new series is added to the xy
Select an entry in the tree viewer chart, corresponding to the
section selected TID SWTBot

A new series is added to the xy
Select another entry from the tree chart, and the previous TID's
viewer series is not displayed anymore Manual

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

LTTng 2.0 - CPU analysis

84702

84702

Christophe: not
sure | understand.
Multiple series can
be selected; when
selecting a 2nd
series, the first one
is still displayed.
Simon: | think this
is old and refers to
an older view. With
the new tree view
the behavior is as
you described
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4.1

4.2

4.3

4.4

4.5

4.6

4.7

4.8

4.9

Drag move time range

Zoom time range (mouse
wheel)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Mouse hover

Drag mouse selection

Shift key selection

Sort columns

Drag move xy chart left and right with

middle button and shift mouse wheel

Zoom with ctrl mouse wheel up and
down, cursor inside xy chart

Scroll with mouse wheel up and
down, cursor outside xy chart

Click and drag vertical scroll bar

Drag select time graph with right
button in xy chart

Hover mouse in xy chart region
anywhere

Drag select xy chart with left button

Click select with left button (begin
time), press shift key and click select
another time (end time)

Click on column headers once then
twice

Time range is dragged. When
mouse button is released, series
are updated and new time range is
propagated to other views.

Time range is zoomed in and out,
relative to mouse cursor. When
mouse wheel is stopped for a short
time, series are updated and new
time range is propagated to other
views, including the tree viewer
beside the chart. The selected
process remains the same.

Table scroll up and down. Selected
process does not change. Vertical
scroll bar updated.

Tree viewer scrolls up and down.
Selected process does not change.

Selection highlighted. When
mouse button is released, time
range is zoomed to selection,
series are updated and new time
range is propagated to other views.
Selected process remains the
same.

Tool tip shows the total and
selected process (if any) cpu
usage at the time

Selection highlighted and selection
range is propagated to other views

Selection highlighted and selection
rang is propagated to other views

Entries are sorted in ascending
then descending order on the
column value. Selected process
does not change.

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - CPU analysis

Christophe:
selected process is
lost if the new time
range does not
contain data from
the process, even
when zooming
back out. Not sure
if it should be
marked as a fail.

Simon: Sometime
with GTK3 sorting
by column cause
the process column
to add extra
padding between
the checkbox and
the label. On GTK2
everything seems
fine
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Drag mouse selection

Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
T2 the second (draggged) selected
time and delta the time difference

LTTng 2.0 - CPU analysis

4.10 (Status bar) Drag select xy chart with left button ~ between T2-T1 (can be negative) Manual
Selection highlighted. Status bar of
Eclipse is updated with time
information: T, T1, T2 and delta,
where T is the time of the mouse
position, T1 the first selected time,
Click select with left button (begin T2 the second (draggged) selected
Shift key selection (Status  time), press shift key and click select time and delta the time difference
4.1 bar) another time (end time) between T2-T1 (can be negative) Manual
5 Keyboard handling
Selected process is changed. xy
Keyboard navigation in tree With focus on table, use UP, DOWN, chart selection is updated. Vertical
5.1 viewer HOME, END keys scroll bar updated. Manual
6 Synchronization
Selected time line is updated. If
selected time is outside current
range, time range is updated to
6.1 Time synchronization Select a random time in another view include it. Manual
Select a new time range in CPU
6.2 Time range synchronization usage view or in Histogram view. Time range is updated. Manual
Selection is highlighted. If the most
left time (T1) of selected time range is
Time range selection In any other view that supports range outside the current range, then time
6.3 synchronisation synchronization, select a new range. range is updated to include it Manual
CPU usage works with
experiments Manual

works with 1 kernel
trace experiments
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Section
TMF - Remote Fetching

Target: Ubuntu 14.04 64 bit

Step

2.1
22

3.4
3.5

3.7
3.8

5.1
52

Test Case

Preparation
Step 1

Opening

Open Profile Editor 1
Open Profile Editor 2

Edit Profile - Add/Delete
Create Profile
Add Node
Add trace group

Add trace
Delete Trace

Delete Trace Group

Delete Connection Node

Remove Profile

Edit Profile - Reorder

Move profile up/down

Move connection node up/down

Move Trace Group up/down

Move Trace up/down

Edit Profile - Copy, Cut, Paste

Copy/Paste Profile
Copy/Paste Profile (Keys)

Copy/Paste Connection Node

Copy/Paste Connection Node
(Keys)

Pass

Action

Open Trace Compass and reset Lttng perspective

Right-click on Traces Folder -> Fetch Remote Traces
.. > Manage Profiles

Fail

Verification

Lttng perspective opens with correct views

The Profile Editor of preference page opens

Window -> Preferences-> Tracing -> Remote Profiles The Profile Editor of preference page opens

Open Profile Editor > Click on 'Add' > Enter profile
name, remote information, root path and trace pattern

Select Profile node > right mouse click > select New
Connection Node'

Select node node > righ mouse click > select New
Trace Group'

Select trace group > right mouse click > select New
Trace'

Select trace > right mouse click > select Delete
Select Trace Group> right mouse click > select
Delete

Select Connection Node > right mouse click > select
Delete

Select Profile > click on 'Remove' button

Create at 2-3 profiles > select 2nd profile and press
buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 connection nodes >
select 1 connection node > click buttons 'Move
Up'/'Move Down'

Make sure that there are 2 or 3 trace gropus > select 1
trace group > click buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace groups > select 1
traces > click buttons 'Move Up'/'Move Down'

Select Profile > click right mouse button on a profile
> Select Copy -> click right mouse button on other
profile > Select Paste

Redo 5.1 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a
Connection Node > Select Copy -> click right mouse
button on other Connection Node > Select Paste

Redo 5.3 with CTRL+C and CTRL+V keys

New Profile is created and template is provided

New Connection Node is create under the profile
and template is provided

New Trace Group is created under the node and
template is provided

New Trace is created under Trace Group and
template is provided

Trace is deleted
Trace Group is deleted

Connection Node is deleted
Profile is deleted

Profiles are moved up and down

Connection Nodes are moved up and down within
a profile

Trace Groups are moved up and down within a
connection node

Traces are moved up and down within a Trace
Group

Profile is pasted under the selected profile

Profile is pasted under the selected profile

Profile is pasted under the selected Connection
Node

Profile is pasted under the selected Connection
Node

To Do
51 0
Type
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
RCPTT Pass
RCPTT Pass
SWTBot Pass
RCPTT Pass
RCPTT Pass
RCPTT Pass
SWTBot Pass
RCPTT Pass
RCPTT Pass
RCPTT Pass
RCPTT Pass

TMF - Remote Fetching

Comment
17

Comment

Bruno : Not this test, but the Fetch Remotes
Traces dialog, has a help button that does
nothing. Patrick: See Bug 440238.
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55
5.6

5.7
5.8
59

6.1
6.2

6.3

6.4

6.5

6.6
6.7
6.8
6.9

7.1

7.2

73

8.1

8.2

8.3

Copy/Paste Trace Group
Copy/Paste Trace Group (Keys)

Copy/Paste Trace
Copy/Paste Trace (Key)
Cut/Paste

Edit Profile - Adverserial
Error empty profile name
Duplicate profile name
Error empty Connection node
name
Duplicate Connection node name

Missing username in URI

Invalid URI

Error empty Trace Group
Error empty Trace
Invalid File pattern

Export/Import Profile
Export Profile
Import Profile
Import Profile

Remote Fetch Wizard

Preparation

Create and run Profile "new
Profile" (syslog + synthetic CTF
trace in sub-directory)

Clear traces

Create and run Profile "new
Profile" (syslog + synthetic CTF

trace in sub-directory), only 1 trace

selected
Clear traces

Select Profile > click right mouse button on a Trace
Group > Select Copy -> click right mouse button on
other Trace Group > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Trace >
Select Copy -> click right mouse button on other
Trace > Select Paste

Redo 5.5 with CTRL+C and CTRL+V keys

Redo 5.1 - 5.8 with cut and paste

Clear profile name
Add profile with name of existing profile

Clear Connection node name

Within a profile, add Connection node with name of
existing node

remove user name of a Connection Node

add invalid URI

Delete Trace Group root path

Delete File Pattern

Add trace with invalid regular expression

Select multipe profiles > Click Export Button >
Select Folder and enter file name > OK

Click on Import Button > select profile XML file >
OK

Redo 7.2

1) Generate CTF trace in
<plugin>/generated/synthetic-trace

2) Import profiles from <plugin>/profiles/test-
profiles.xml

1) Create Profile with Local connection, 1 trace group
(root /tmp/traces/) and 2 traces (.*syslog.* and .
*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) Click on 'Finish'

Delete all traces from Traces directory

1) Create Profile with Local connection, 1 trace group
(root /tmp/traces/) and 2 traces (.*syslog.* and .
*synthetic.*) in this group

2) Select profile in Fetch Remote Traces wizard
(Remote Profile page)

3) Click on 'Next' button

4) deslect the synthetic CTF trace

5) Click on 'Finish'

Delete all traces from Traces directory

Profile is pasted under the selected Trace Group
Profile is pasted under the selected Trace Group

Profile is pasted under the selected Trace
Profile is pasted under the selected Trace
Successful cut and paste

Error message "Profile must not be empty"

Error message "<name>: Duplicate profile name"

Error message "Node name must not be empty"

Error message "Duplicate node names"

Error message "URI must include user
information"

Error message "URI must include valid host and
port number" or "Unsupported URI scheme"

Error message "Root path must not be empty"
Error message "File pattern must not be empty"
Error message "Invalid file pattern"

Only selected profiles are exported

Profiles are imported

after second import an error message appears
"Duplicate profile names"

Verify that all test traces are imported with correct
trace types assigned. Verify that folder structure is
preserved.

All traces deleted

Verify that only the selected traces are imported
with correct trace types assigned. Verify that
folder structure is preserved.

All traces deleted

RCPTT
RCPTT

SWTBot
RCPTT
RCPTT

RCPTT
RCPTT

RCPTT

RCPTT

RCPTT

RCPTT
RCPTT
RCPTT
RCPTT

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

TMF - Remote Fetching

Trace (5.7) is done with SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot
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8.4

8.5

8.6

8.7

8.8

8.9

8.10

8.12

Run Profile "TestAllRecursive"

Re-run Profile "TestAllRecursive"
(Rename)

Re-run Profile "TestAllRecursive"
(Overwrite)

Re-run Profile "TestAllRecursive"
(Skip)

Re-run Profile "TestAllRecursive"
(Overwrite 2)

Clear traces

Re-run Profile "TestAllRecursive"
(@)

Clear traces

Run Profile
"TestAllNonRecursive"

Clear traces

Run Profile
"TestSpecificRecursive"

Clear traces

Run Profile
"TestSpecificNonRecursive"

Clear traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) In dialog box select 'Rename' for the first trace and
'Rename ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) In dialog box select 'Overwrite' for the first trace
and 'Overwrite ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) In dialog box select 'Skip' for the first trace and
*Skip ALL' for the second traces

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Select checkbox 'Overwrite traces without
warning'

3) Click on 'Next' button (enter password if needed)
4) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)
2) Click on 'Finish' (enter password if needed)

Delete all traces from Traces directory

1) Select profile "TestAllNonRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificRecursive" in Fetch
Remote Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestSpecificNonRecursive" in
Fetch Remote Traces wizard (Remote Profile page)
2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

Verify that all test traces are imported with correct
trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.
log is importeds with unrecognized trace type.
Make sure that directory structure is preserved.

Verify that all test traces are imported with new
name and correct trace types assigned (LTTng
kernel, LTTng UST, custom text, custom XML).
The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

Verify that all test traces are imported with correct
trace types assigned where old traces are
overwritten. (LTTng kernel, LTTng UST, custom
text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make
sure that directory structure is preserved.

Verify that all test traces are skipped and no trace
is imported

Verify that all test traces are imported with correct
trace types assigned where old traces are
overwritten (no dialog box opens). (LTTng kernel,
LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized
trace type. Make sure that directory structure is
preserved.

All traces deleted

Verify that all test traces are imported with correct
trace types assigned. The second page is omitted.
(LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that only traces from root path are imported
(LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs
are imported from root and subdirectory. Make
sure that directory structure is preserved.

All traces deleted

Verify that only kernel and custom text/XML logs
are imported from root directory only. Make sure
that directory structure is preserved.

All traces deleted

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

TMF - Remote Fetching

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot
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8.13

8.15

9.1

9.2

10

10.2

Run Profile
"TestSpecificMutliGroupRecursiv
"

Clear traces

Cancel Import
Clear traces

Run Profile "TestMultiNodes"

Connection Handling

Error cannot connect to remote
host (node doesn't exist)

Error cannot connect to remote
host (wrong password)

Other Remote Backends
Clear traces

Remote Fetch using SSH

1) Select profile "TestSpecificMultiGroupRecursive"

in Fetch Remote Traces wizard (Remote Profile page) Verify that only traces from root path are imported

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Delete all traces from Traces directory

1) Select profile "TestAllRecursive" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

4) Cancel import (red square or Cancel button)
Delete all traces from Traces directory

1) Select profile "TestMultiNodes" in Fetch Remote
Traces wizard (Remote Profile page)

2) Click on 'Next' button (enter password if needed)
3) Click on 'Finish'

Create profile with IP address that cannot be
connected to and run profile

Create profile with valid IP address. When asked for
password enter invalid password

Delete all traces from Traces directory

Update profile with local username and run test 9.2
entering the correct password

(LTTng kernel, LTTng UST, custom text, custom
XML). Make sure that directory structure is
preserved.

All traces deleted

Verify that import operation is cancelled
All traces deleted

Verify that only traces from root path are imported
(LTTng kernel, LTTng UST, custom text, custom
XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved. 2 nodes directories are
created with the above traces stored

Operation to connect to remote node fails and error
dialog is shown with detailed information (after
time-out)

Operation to connect to remote node fails with
time-out and error dialog is shown with detailed
information. Note time-out is as per remote
development preferences

All traces deleted

Verify that all test traces are imported with correct
trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.
log is importeds with unrecognized trace type.
Make sure that directory structure is preserved.

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual

TMF - Remote Fetching

Local connection is used in SWTBot

Local connection is used in SWTBot

Local connection is used in SWTBot

Verified in Aug. 22-2018 at 11:46AM. SWTBot test
can be run locally by removing the @Ignore tag

46



4.3.0-TraceCompassTestCases

Section

LTTng 2.0 - Control Flow View

Target: Windows
Step Test Case
0 Prerequisites
0.1 Import traces
0.2 Create experiment

1 View management
1.1 Open perspective

1.2 Open trace

1.2 Open experiment
1.3 Close view

1.4 Open view
2 View selection
21 Select process in table

2.2 Select process in time graph

2.3 Select state in time graph
3 Mouse handling

3.1 Drag move chart area

3.2 Zoom time range (mouse wheel)

3.3 Zoom time range (mouse drag)

3.4 Mouse vertical scroll

3.5 Vertical scroll bar

Pass

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Control Flow view

Open the Control Flow view

Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down, cursor
inside time graph while holding the Ctl button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down

Click and drag vertical scroll bar

Fail

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.
View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table. Selected
time line is updated. Other views are
synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line is
updated. Other views are synchronized to
selected time.

Visible range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change.

Type To Do
15 0

SWTBot Pass
SWTBot Pass

Manual Pass
SWTBot Pass
SWTBot Pass

Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
0

Comment

LTTng 2.0 - ControlFlowView
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3.6 Drag zoom time range

3.7 Double-click reset time range

3.8 Mouse hover (empty region)

3.9 Mouse hover (state)

3.10 Drag mouse selection

3.11 _Shift key selection
4 Keyboard handling

Keyboard navigation in time graph

4.1 (process selection)

Keyboard navigation in time graph

4.2 (state selection)
5 Tool bar handling

5.1 Show Legend

5.2 Reset Time Scale

5.3 Select Previous/Next Event

5.4 Select Previous/Next Process

5.5 Zoom In/Out
5.6 Filter Dialog

5.7 Filter Processes

5.8 Hide Arrows

5.9 Follow CPU Forward

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time

(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button
Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes
3) Press Ok

Click Hide Arrows button

With focus on time graph, click Follow CPU
Forward button

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows process name only.

Tool tip shows process name, state name,
date, start time, stop time, duration. For
USERMODE state, CPU is shown. For
SYSCALL state, CPU and System Call is
shown. For INTERRUPTED state, CPU is
shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

“negative)

Selected process is changed. Table selection
is updated. Vertical scroll bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

Verify that all buttons are working correctly

Verify that only selected processes are
displayed in the view

Verify that arrows are not drawn in the time
graph

Time graph is updated to show the next state
for this cpu following the arrow, the event is
selected in the Events editor.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot

SWTBot

Manual

Manual
SWTBot

SWTBot

Manual

SWTBot

LTTng 2.0 - ControlFlowView
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6.1

6.2

6.3

6.4

7.1

7.2

7.3

7.4

7.5

7.6
7.7

Follow CPU Backward

Optimize

Re-Optimize

Go to next event of selected thread

Go to previous event of selected
thread

Synchronization

Time synchronization

Event synchronization

Window range synchronization

Selection range synchronization

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range (no
overlap)

Select other trace (no overlap)

Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces

With focus on time graph, click Follow CPU
Backward button

Click on the optimize button

Click on the optimize button a few more times

Select a thread and click on go to next event
of selected thread

Select a thread and click on go to previous
event of selected thread

Select a random time in another view
Select a state-impacting event
(sched_switch, syscall, ...) in events table or
in Resources view using Select
Previous/Next event.

Select a new window range in Resources
view or in Histogram view.

In any other view that supports selection

range synchronization, select a new range.

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace ${local}
[traces/import/kernel-overlap-testing

3) Import UST ${local}
[traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

Select a time and new range

Select different trace by clicking its Events editor
tab

- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-
click -> "Follow time updates from other traces"

Select a time and new range
Select different trace by clicking its Events editor

tab
Close all Events editor tabs

Time graph is updated to show the previous
state for this cpu following the arrow, the
event is selected in the Events editor.

verify that the processes are closer together.

verify that the processes did not move, the
optimization is stable

Verify in the events table that the selected
thread is the same as the previous event

Verify in the events table that the selected
thread is the same as the previous event

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

In addition to updating the selected time, the
process containing the state change is
selected and revealed. Vertical scroll bar is
updated if necessary.

Window range is updated.

Selection is highlighted. If the left time (T1) of
selected time range is outside the current
range, then window range is updated to

include it

View shows the last opened trace

Selected time line and time range is updated to
selected time and new range.

View is updated to show selected trace. Selected
time line and time range are restored to the

selected trace's previously selected time and range.

View shows the last opened trace

Selected time line and time range is updated to
selected time and new range.

View is updated to show selected trace. Selected
time line and time range are set to the newly
selected time and range.

View is cleared.

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

LTTng 2.0 - ControlFlowView
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| 8.1 | Filtering

LTTng 2.0 - ControlFlowView

Preparation

8.1 Apply filter (1st trace)

8.2 Apply filter (2nd trace)

8.3 Persitent filter

9 ‘Miscellaneous

9.1  Restart (Bug 409345)

9.2 Select single time (Bug 477009)

Window range synchronization

93  (Bug477012)

Open 2 LTTng Kernel Traces

1) Open filter dialog

2) Create filter

3) Click on OK

1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog

3) Create filter

4) Click on OK

Switch between both open traces

1) Open LTTng Kernel Trace
2) Select Control Flow View
3) Restart Eclipse

1) Open LTTng UST trace while CFV is open

2) Select event in events table

1) Open Control Flow view, Resources view
and a kernel trace. Initial window range is

'range 1".

2) Go "right one page" on Control Flow view

by pressing right arrow in scroll bar.

3) Go "left one page" on Resources view by

pressing left arrow in scroll bar.

4) Go "right one page" on Control Flow view.

Make sure that only selected processes of
filter dialog are shown

Make sure that only selected processes of
filter dialog are shown

Make sure that previously set filter are still
available

Verify that Control Flow View is populated

Verify that Control Flow View is empty, current
window range stays change to ensure visibility

Verify that after each step the initial window
range doesn't change

SWTBot

Manual

Manual

Manual

Manual

Manual
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Section

LTTng 2.0 - Resources View

Target: Windows 7
Step Test Case
0 Prerequisites
0.1 Import traces

0.2 Create experiment

=y

View management

1.1 Open perspective

1.2 Open trace

1.2 Open experiment
1.3 Close view

1.4 Open view
2 View selection

2.2 Select resource in time graph

23 Select state in time graph
3 Mouse handling

3.1 Drag move canvas

3.2 Zoom time range (mouse wheel)

3.3 Zoom time range (mouse drag)

3.4 Mouse vertical scroll

3.5 Vertical scroll bar

3.6 Drag select time range

Pass

Action

Import LTTng Kernel traces in Tracing project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective, and
select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces in
Project Explorer

Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down on
header or Ctrl+mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down, cursor
outside time graph (in name space)

Click and drag vertical scroll bar

Drag select time graph with right button

Fail

Verification

Resource view opens.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.
View is closed.

Resources view is opened and populated with
processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is
released, states are updated and new window
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Time graph scroll up and down and remain
aligned. Selected process does not change.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

To Do
6 0

SWTBot Pass
SWTBot Pass
Manual Pass
SWTBot Pass
SWTBot Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass
Manual Pass

Comment
1

Comment

LTTng 2.0 - ResourcesView
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3.7 Double-click reset time range

3.8 Mouse hover (empty region)

3.9 Mouse hover (state)

3.10 Drag mouse selection

3.11  Shift key selection
4 Keyboard handling

Keyboard navigation in time graph

4.1 (process selection)

Keyboard navigation in time graph

4.2 (state selection)
5 Tool bar handling

5.1 Show Legend

5.2 Reset Time Scale

5.3 Select Previous/Next Event

5.4 Select Previous/Next Process

5.5 Zoom In/Out

5.6 Filter Dialog
6 Synchronization

6.1 Time synchronization

6.2 Time range synchronization

Time range selection
6.3 synchronisation

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time

(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT

keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next State button

Click Previous/Next Process button

Click Zoom In/Out button

~ Open Filter Dialog

Select a random time in another view

Select a new time range in Control Flow view
or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state, CPU
is shown.On usermode and syscall tool tip
shows also shows hover time, tid and process
name.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the first selected time, T2 the
second (dragged) selected time and delta the
time difference between T2-T1 (can be

_negative)

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated to
other views.

_Verify that all buttons are working correctly

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
range, then time range is updated to include it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - ResourcesView
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7 Multiple Trace Synchronization
1) Download traces.zip (if necessary) and
unzip into a local directory ${local}
2) Import kernel trace ${local}
[traces/import/kernel-overlap-testing
3) Import UST ${local}
[traces/import/trace ust-overlap-testing
4) Create experiment with trace of 2) in it
Preparation
7.1 Open multiple traces (no overlap) Open multiple traces that don't overlap in time View shows the last opened trace Manual
Change selected time and range (no Selected time line and time range is updated to
7.2 overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are restored to the
7.3 Select other trace (no overlap) tab selected trace's previously selected time and range. Manual
- Open multiple traces that overlap in time
- For both traces, in Events table right mouse-
7.4 Open multiple traces (overlap) click -> "Follow time updates from other traces"  View shows the last opened trace Manual
Change selected time and range Selected time line and time range is updated to
7.5 (overlap) Select a time and new range selected time and new range. Manual
View is updated to show selected trace. Selected
Select different trace by clicking its Events editor time line and time range are set to the newly
7.6 Select other trace (overlap) tab selected time and range. Manual
7.7 Close all traces Close all Events editor tabs View is cleared. Manual
81  Filtering [
Preparation Open 2 LTTng Kernel Traces
1) Open filter dialog
2) Create filter Make sure that only selected processes of
8.1 Apply filter (1st trace) 3) Click on OK filter dialog are shown SWTBot
1) Switch to 2nd trace (keep 1st open)
2) Open filter dialog
3) Create filter Make sure that only selected processes of
8.2 Apply filter (2nd trace) 4) Click on OK filter dialog are shown Manual
Make sure that previously set filter are still
8.3 Persistent filter Switch between both open traces available Manual
9 ‘Miscellaneous
1) Open LTTng Kernel Trace
2) Select Resource View
9.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Resources View is populated Manual

LTTng 2.0 - ResourcesView

Project Explorer should keep track the current trace
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Section
LTTng 2.0 - Control
View

Target: Ubuntu 16.04 64 bit

Step

0.1

1.1

21

22

3.1

33

»

4

35

36

37

38

LTTng Tools 2.9.6, Built-in
SSH

Test Case

Prerequisites

Set Proxy

General

Open perspective
Manage View
Close view

Open Control view

Connection Handling

Create Host Connection

Disconnect

Connect

Select Host Connection

Node contexts sensitive
menu (host connected)

L

For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.5.x or later) is required. Make sure that the
root session daemon is running (sudo lttng list -k) and have one
UST process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

a) Window — Preferences — General — Network Connections
b) Set “Active Provider” to “Direct”

Open and reset LTTng Kernel Perspective

Close Control View

Use menu Window — Show View — Other ... — Lttng —
Control

1) Click Button 'New Connection.
2) Select Tree item "Built-in SSH" and click on Create

3) Enter Connection Name (e.g. MyHost), enter Host Name (a
DNS name or IP address), username and password

4) Click 'Finish"

5) In Tree select the newly create connection and click on 'Ok’

a) Select host to disconnect and click Button 'Disconnect
b) Redo test with context sensitive menu item 'Disconnect'

a) Select host to connect and click Button 'Connect
b) Redo test with context sensitive menu item ‘Connect'

1) Restart Eclipse
2) Click Button 'New Connection..."

3) Select the host previously created

4) Select 'OK'. (Afterwards enter user ID and Password if
necessary)

1) Connect to remote host
2) select connected node and click right mouse button

View button enable state 1) Connect to remote host (if necessary)

(host connected)

Node contexts sensitive
menu (host
disconnected)

2) select connected node

1) Disconnect from node
2) select disconnnected node and click right mouse button

View button enable state 1) Disconnect to remote host (if necessary)

(host connected)

2) select disconnected node if necessary

Verification

LTTng Tracer Control User Guide: http:

LTTng Kemel perspective opens with
correct Control view on the left bottom
comer

Control view is removed from
perspective

Verify that Control view is shown

Make sure that after 4) the new
connection is shown in the tree. Verify
that the new host is shown in the
Control view (with 'Connection Name'.
After Ssh connection has been
established, make sure that Provider
and Session nodes are created in the
Control view underneath the host.
Verify that all active Providers (Kemel
and UST providers) are shown under
the 'Provider’ node.

Verify that icon for the corresponding
node changes to the disconnect icon
and all sub-nodes are removed.
Verify that icon for the corresponding
node changes to the connected icon
and after successful SSH connection
all data is retrieved form the remote
host (Providers, sessions etc)

Make sure that SSH connection is
established and all data is retrieved
from the remote host ( (Providers,
sessions etc).

Verify that menu items are shown and
enabled/disabled depending on state:
'Connect' (disabled)

Disconnect (enabled)

Refresh (enabled)

Delete (disabled)

Verify enable state of view buttons:
"New Connection...' (enabled)
'Connect’ (disabled)
'Disconnect’ (enabled)
'Refresh’ (enabled)

'Delete’ (disabled)

'Start' (disabled)

'Stop' (disabled)

‘Destroy Session...' (disabled)
‘Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that menu items are shown and
enabled/disabled depending on state:
‘Connect (enabled)

‘Disconnect’ (disabled)

‘Refresh’ (disabled)

‘Delete’ (enabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
‘Connect' (enabled)
‘Disconnect' (disabled)
‘Refresh’ (disabled)

‘Delete’ (enabled)

‘Start' (disabled)

‘Stop' (disabled)

‘Destroy Session...' (disabled)
'Record Snapshot' (disabled)
"Import..." (disabled)

LTTng 2.0 - Control

Type  ToDo Comment

Comment

SWTBot

Manual

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT
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3.9

3.10

42

43

4.4

4.5

4.8

49

411

4.12

a) Select node to delete (state disconnected) and click on
button 'Delete’
b) Redo test with context sensitive menu item ‘Delete’

Delete

Create Host Connection re-do 3.1 but this time specify a port number other than default
with ssh port SSH port 22

Session Handling
Preparation 1) Connect to remote host

Sessions Context
Sensitive Menu Select 'Sessions' in tree and click right mouse button

1) Click right mouse button on ‘Sessions’

2) Select ‘Create Session..." in the context sensitive menu
Create Session (default 3) Enter session name "MySession’, keep 'Session Path’ empty
location) 4) Select 'Ok’

1) Click right mouse button on 'Sessions"
2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MyOtherSession"
Create Session (custom 4) enter custom path (/tmp/myTraces) for 'Session Path'
location) 5) Select 'Ok’

Create Session — 1) Click right mouse button on 'Sessions’
session already exists in 2) Select 'Create Session..." in the context sensitive menu
GUI 3) Enter session name 'MySession', keep 'Session Path' empty

1) login to the remote host using a command shell

2) type Ittng create newSession and press enter. This will create

a session which is not know by the Control view.

3) Click right mouse button on 'Sessions'
Create Session — 4) Select 'Create Session..." in the context sensitive menu
session already exists  5) Enter session name ‘newSession', keep 'Session Path' empty
on node 6) Select 'Ok’

Session Context
Sensitive menu (session
inactive) Select newly created session and click right mouse button

View button enable state
(session inactive) Select newly created session (enable an event before)

a) Enable an event
b) Select session and click on button 'Start
Start Session ¢) Redo test with context sensitive menu item ‘Start’

Session Context
Sensitive menu (session
active) Select started session and click right mouse button

View button enable state
(session active) Select started session

1) In the Control view select session 'MyOtherSession'

2) Click right mouse button

3) select 'Destroy Session..." in the context sensitive menu
Destroy Session 4) Select 'Ok in the confirmation dialog box

Verify that host is removed from the
control view.

The connection should fail (unless
remote is configured for the specified
port)

Verify that menu items are shown and
enabled: 'Refresh', 'Create Session...",
Load..." and 'Execute Command Script

Verify that new session is added under
the Session tree node. Verify
properties in Properties view (by
selecting the session in the Control
view):

'Session name' (=MySession)

'Session Path"
(=/home/<user>/traces/MySession_<d
ate and time>) and 'State’
(=INACTIVE)

Verify that new session is added under
the Session tree node. Verify
properties in Properties view (by
selecting the session in the Control
view):

'Session name' (=MyOtherSession)
'Session Path' (=/tmp/myTraces) and
'State' (<INACTIVE)

Make sure that an error message
appears in the message area of the
dialog box with information that
session 'MySession' already exists in
the tree.

Verify that an error dialog box will
show with information that command

create a session failed. session
already exists on the node. Select
'Details": Verify that the command
error detail is shown (with return value
(28

Verify context sensitive menu items:
‘Refresh’ (enabled)

‘Start' (enabled)

'Stop' (disabled)

'Destroy Session...' (enabled)
‘Import..." (enabled)

'Save...' (enabled)

'Enable Channel..." (enabled)
'Enable Event (default channel)..."
(enabled)

'Record Snapshot' (disabled)

Verify enable state of view buttons:
'New Connection..." (enabled)
'Connect’ (disabled)

'Disconnect’ (disabled)

'Refresh’ (enabled)

'Delete’ (disabled)

'Start' (enabled)

'Stop' (disabled)

'Destroy Session..." (enabled)
‘Import..." (enabled)

'Record Snapshot' (disabled)
Verify that Session icon changes to
‘ACTIVE' icon. Verify that property
view shows 'ACTIVE' for the session
state

Verify context sensitive menu items:
'Refresh’ (enabled)

'Start' (disabled)

'Stop’ (enabled)

'Destroy Session..." (disabled)
‘Import..." (disabled)

'Enable Channel..." (disabled)
'Enable Event (default channel)..."
(disabled)

Verify enable state of view buttons:
‘New Connection..." (enabled)
‘Connect' (disabled)

‘Disconnect’ (disabled)

‘Refresh’ (enabled)

'Delete’ (disabled)

'Start' (disabled)

'Stop' (enabled)

'Destroy Session..." (disabled)
‘Import..." (disabled)

Verify that session is removed from
the control view.

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT

RCPTT

SWTBot

30 seconds pause in the test to create manualy a
session on the host

LTTng 2.0 - Control
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5.1

52

53

54

55

56

57

58

6.1

71

72

73

74

Kernel Channel
Handling

Preparation

Enable Channel on
session level (default
values)

Enable Channel on
domain level (changed
values)

Enable Channel —
channel already exists

Domain Context
Sensitive menu

Channel Context
Sensitive menu

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on
session level (default
values)

Enable/Disable Channel

Kernel Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (syscalls)

Enable Event on
Channel level (Dynamic
Probe)

Enable Event on
Channel level (Dynamic
Function Probe)

Disable Event

1) Connect to remote host
2) Create new Session 'MyOtherSession'

1) Select session and right mouse click

2) Select menu item 'Enable Channel..."

3) Enter Channel name (e.g. myChannel) and keep default
values

4) Select Kernel

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel..."

3) Enter Channel name (e.g. MyOtherChannel)
4) Change values

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click

2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep
default values

4) Click on 'Ok

Select domain 'Kernel' and click right mouse button

Select channel 'MyChannel' and click right mouse button

1) Select channel '"MyChannel' and click right mouse button
2) Select 'Disable’' menu item

1) Select channel '"MyChannel' and click right mouse button 2)
Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel..."
3) Enter Channel name 'MyChannel'

4) Select UST

5) Click on Button 'Default'

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...
3) Select 'Kemel

4) Select Radio button for Tracepoint Events'

5) Select top level tree node ‘Al

6) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)..."
3) Select 'Kernel'

4) Select Radio button for 'All Syscalls'

5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button

2) Select menu item 'Enable Events
3) Select Radio button for 'Dynamic Probe’
4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,

see file /boot/System.map<kernel version>, valid symbols have

T ortas type, | used 'backtrace_stack' for example)
5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse button

2) Select menu item 'Enable Event:
3) Select Radio button for 'Dynamic Function Entry/Return
Probe'

4) Enter Event Name 'MyOtherEvent' and Probe (e.g.

Verify that domain 'Kernel' is created
under session and channel is added
under the domain. Verify that default
values for the channel are displayed in
the Properties view after selecting the
channel in the tree.

Verify that channel is added under the
domain. Verify that correct values for
the channel are displayed in the
Properties view after selecting the
channel in the tree.

Verify that error dialog box is opened
notifying that channel already exists.

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel...' (enabled)
'Enable Event (default channel)..."
(enabled)

‘Add Context...” (enabled)

Verify context sensitive menu items:
'Refresh’ (enabled)

"Enable Channel' (disabled)
'Disable Channel' (enabled)

'Enable Event (default channel)..."
(enabled)

'Add Context...” (enabled)

Verify that channel is disabled
(disabled channel icon shown, state
DISABLED shown in Properties view,
menu item 'Disable’ is disabled and
menu item 'Enable’ is enabled
Verify that channel is enabled
(enabled channel icon shown, state
ENABLED shown in Properties view,
menu item 'Disable’ is enabled and
menu item 'Enable’ is disabled

Verify that domain 'UST global' is
created under session and channel is
added under the domain. Verify that
default values for the channel are
displayed in the Properties view after
selecting the channel in the tree.

See 5.7/5.8

Verify that default channel (channel0)
is create under domain 'Kernel' and
that all tracepoint events are added
under the channel with state
ENABLED. Verify properties view
show correct values when selecting a
the tree (Event

Verify that event with name syscalls is
added under the default channel
(channel0) with state ENABLED.
Verify properties view show correct
values when selecting a event in the
tree (Event Type=SYSCALL,
State=ENABLED)

Verify that event with name "MyEvent'
is added under the respective channel
with state ENABLED. Verify properties
view show correct values when
selecting a event in the tree (Event
Type=Probe, State=ENABLED,
Address=0xc0101280, Event
Name=MyEvent)

Verify that event with name:
'MyOtherEvent' is added under the
respective channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event

create_dev, see file or
version>)

5) Click on Ok

1) Select multiple events (tracepoint events) under a channel
(not syscalls) and click right mouse button
2) Select 'Disable’ menu item

Typ , ED,
Symbol=create_dev, Offset=0x0,
Event Name=MyOtherEvent)

Verify that all selected events are
disabled (disabled event icon is
shown, state DISABLED is shown in
Properties view, menu item 'Disable’ is
disabled and menu item 'Enable’ is
enabled

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot
RCPTT

SWTBot

SWTBot

RCPTT

RCPTT

RCPTT

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable
each separately.

Command to change state of events failed

Command failed! Command: Ittng --mi xm| enable-event MyEvent -k -s auto-20160607-005527 -c sdf -probe Oxffffff820a25(5

Error Output:

Error: Event MyEvent: Enable kerel event failed (channel sdf, session auto-20160607-005527)

Retun Value: 43
<?xml version="1.0" encoding="UTF-8"?>

LTTng 2.0 - Control

<command xmins='

Command to change state of events failed

Command failed! Command: Ittng --mi xml enable-event bob -k -s MyOtherSession ~function create_dev

Error Ouptut:

Error: Event bob: Non-default channel exists within session: channel name needs to be specified with '-c name' (channel <default>, session MyOtherSession)

Retum Value: 83
<7xmi version="1.0" encoding="UTF-8"?>

UNCTIO!

P

yp:
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76

78

8.1

8.2

8.3

8.4

85

8.6

8.7

9.1

9.2

9.3

Enable Event (tracepoint
events)

Enable Event (probe
events)

Enable Tracepoint Event
using filter in tree (Bug
450526)

UST Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (wildcards)

Enable Event on
Channel level (log level)

Enable Event on
Channel level (log level
oly)

Enable/Disable Event
(tracepoint events)
Enable/Disable Event
(tracepoint events)

Enable Tracepoint Event
using filter in tree (Bug
450526)

Enable Event by name
Contexts Handling

Add Context (to
channel)

Add Context (to
channel)

Add Context (to event)

1) Select multiple disabled events and click right mouse button
2) Select 'Enable' menu item

1) Select a probe event (function or dynamic probe) disabled
events and click right mouse button

2) Select 'Enable’ menu item

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter a filter (e.g. sched) for the tracepoint tree and then
select All

4) Click on Ok

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel).
3) Select 'UST"

4) Select Radio button for "Tracepoint Events'

5) Select top level tree node "All'

6) Click on Ok

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)...
3) Select Radio button for 'Wildcard'

4) Enter a wildcard (e.g. ust")

5) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Log Level

4) Enter Event Name 'MyEvent'

5) Select log level TRACE_ERR

6) Select radio button for loglevel

7) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button

2) Select menu item 'Enable Events..
3) Select Radio button for 'Log Level
4) Enter Event Name 'MyOtherEvent'
5) Select log level TRACE_INFO

6) Select radio button for loglevel-olny
7) Click on Ok

Redo tests 7.5 and 7.6 with UST tracepoint events

Redo tests 7.5 and 7.6 with UST (loglevel/loglevel-only) events
1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter filter for the tracepoint tree and then select All

4) Click on Ok

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channely

3) Select Tracepoints

4) Enter list of names (comma-separated) in text box

5) Click on Ok

1) Select kernel channel and click right mouse button
2) Select menu item 'Add Contexts..."
3) Expand tree and select some contexts (e.g prio, procname,

pid)
4) Click on 'Ok

1) Select UST channel and click right mouse button
2) Select menu item 'Add Contexts..."
3) Expand tree and select contexts procname, pthread_id, vpid

and vtid
4) Click on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse button
2) Select menu item ‘Add Contexts..."

3) Expand tree and select some contexts (e.g prio, procname,
pid)

4) Click on 'Ok

Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or
later this menu item has to be disabled

Verify that selected events are
enabled (enabled event icon is shown,
state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled
and menu item ‘Enable’ is disabled
Verify that selected events are
enabled (enabled event icon is shown,
state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled
and menu item 'Enable’ is disabled

Verify that only the selected
tracepoints (filtered) are enabled and
not all kernel tracepoionts

Verify that default channel (channel0)
is create under domain 'UST global'
and that a wildcard event **" is create
under the channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
TRACEPOINT,

Verify that event with wildcarded name
(e.g ust’) is added under the default
channel (channel0) with state
ENABLED. Verify properties view
show correct values when selecting a
eventin the tree (Event
Type=TRACEPOINT,
State=ENABLED)

Verify that event with name '"MyEvent'

is added under the respective channel
with state ENABLED. Verify properties
view show correct values when

Verify that event with name
"MyOtherEvent' is added under the
respective channel with state
ENABLED. Verify properties view
show correct values when selecting a
event in the tree (Event
Type=TRACEPOINT,
State=ENABLED, Log Level=
RACE_INFO, Event
Name=MyOtherEvent).

See 7.5/7.6

See 7.5/7.6

Verify that only the selected trace
points (filtered) are enabled and not all
UST trace poionts

Verify that events entered in the comma-
separated list are added to the tree

Verify that command is successful (no
error).

NOTE: There is no way to retrieve
added contexts from the trace.
Therefore GUI cannot display this
information.

Verify that command is successful (no
error).

NOTE 1: There is no way to retrieve
added contexts from the trace.
Therefore GUI cannot display this
information.

NOTEZ2: For UST only contexts
procname, pthread_id, vpid and vid
are supported

Verify that command is successful (no
error).

NOTE: There is no way to retrieve
added contexts from the trace.
Therefore GUI cannot display this
information.

Note: Disable and Enable menu item is only enabled for
events of the same type, all tracepoints or all sys calls.
For function and dynamic probe the user has to enable

RCPTT each separately.

RCPTT

RCPTT

RCPTT

RCPTT

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a range (e.g. <=
TRACE_ERR) This will be displayed by the properties

SWTBot view now

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g.
TRACE_INFO) This will be displayed by the properties
view now

RCPTT

RCPTT

RCPTT

RCPTT

SWTBot

RCPTT

RCPTT

SWTBot DEPRECATED

LTTng 2.0 - Control
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1) Create a new session
2) Select multiple Kernel Tracepoint events under Providers —
Kernel
3) click right mouse button
4) select menu item 'Enable Event..."
5) Select newly created session
10.1 Enable Kernel Events  6) Select 'Ok’

1) Make sure that UST application is running on remote host
(see step 0)
2) Create a new session
3) Create a channel under domain 'UST global'
4) Select multiple UST Tracepoint events under Providers ->
<UST Process>
5) click right mouse button
6) select menu item 'Enable Event..."
7) Select newly created session
8) Select newly created channel
10.2 Enable UST Events 9) Select 'Ok’

Verify that domain 'Kernel' is created

under the new session. Verify that

default channel ‘channel0' is created

under the domain. Verify that selected

events are added under the channel

and are ENABLED. RCPTT

Verify that selected events are added
under the selected channel and are
ENABLED. RCPTT

1) Create new session

2) Enable all Kernel Tracepoint events

3) Enable all Kernel sycalls

4) Enable all UST events

5) Start Tracing

6) Stop Tracing after a few seconds
1.1 Preparation 7) Create new Tracing Project

1) Select session from 11.1 and click right mouse button
2) Select 'Import.."

1.2 Import to project 3) Select Ok
1) Repeat step 1 - 3 of test case 11.2
Import to project 2) In dialog box select 'Overwrite' (kernel trace)
(Override) 3) In dialog box select 'Overwrite' (UST trace, re-do if more
1.3 than 1 UST trace)

1) Repeat step 1 - 3 of test case 11.2
Import to project 2) In dialog box select ‘Overwrite All
1.4 (Overwrite All)

1) Repeat step 1 — 3 of test case 11.2
2) In dialog box select 'Rename’ (kernel trace)

Import to project 3) In dialog box select 'Rename’ (UST trace, re-do if more than
115  (Rename) 1 UST trace)
1) Repeat step 1 - 3 of test case 11.2
Import to project 2) In dialog box select 'Rename All'

116 (Rename All)

1) Repeat step 1 - 3 of test case 11.2

2) In dialog box select 'Skip' (kernel trace)

3) In dialog box select 'Skip' (UST trace, re-do if more than 1
1.7 Import to project (Skip) UST trace)

1) Repeat step 1 - 3 of test case 11.2

Import to project (Skip  2) In dialog box select 'Skip All'
Ally

Press refresh button and context sensitive menu item for
12.1 Refresh different selections

After 2 verify that all traces are
selected by default and also that the
tracing project with name 'Remote’ is
selected.

Verify that during import a progress
dialog is opened to show the progress
of the import operation.

Verify that traces are imported to the
project wiith name Remote and its
Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel
Trace" is set and for the UST traces
the trace type "LTTng UST Trace" is
set.

Create Experiment, select all traces
and open Experiment. Make sure that
all view are populated correctly in the

LTTng Kernel Perspective. RCPTT Experiment not tested with populated views

Verify that traces are imported and
existing traces are overwritten SWTBot Tested with Remote Fetching 8.6

Confirmation dialog only shows once.
Verify that traces are imported and
existing traces are overwritten RCPTT Hard to be sure that the overwrite worked

Verify that traces are imported with a
different name SWTBot Tested with Remote Fetching 8.5
Confirmation dialog only shows once.
Verify that all traces are imported with
a different name RCPTT

Verify that each skipped trace is not
i rted

importe SWTBot Tested with Remote Fetching 8.7

Confirmation dialog only shows once.
Verify that all traces are skipped Hard to be sure that the skip worked

Verify that the Control View is
refreshed. Manual

LTTng 2.0 - Control
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14.1

14.2

15.2

16.3

Preparation

Enable UST Event on
session level

Enable UST Event from
provider

Create trace

Create Session With
Advanced Options
LTTng v2.1)

Create Session Dialog -
Advanced Button

Create Session Dialog -
Check box "Use same
protocol and address for
data and control”

Create Session Dialog -
Protocol list

Create Session Dialog -
Protocol list 2

Create Session Dialog -
Protocol propagation
Create Session Dialog -
Address propagation

Create Session Dialog -
Protocol propagation 2

For the tests below a Ubuntu machine with LTTng 2.1 installed

(with Ittng tools 2.1.x) is required. Either create a VM machine

yourself (e.g. on Virtualbox) or install it locally on your native

Ubuntu (if correct version). Make sure that the root session

daemon is running (sudo Ittng list -k) and have one UST

process running (e.g. from Ittng-tools git repository under

tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'FilterSession’
Verify that default channel (channel0)
is create under domain 'UST global'
and that the corresponding event is
created under the channel with state

ENABLED.

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)..." Verify that Properties view shows

3) Select 'UST" correct values for this event (Event

4) Select Radio button for "Tracepoint Events' Type=TRACEPOINT,

5) Select one tracepoint State=ENABLED, Filter=with filter,

6) Enter filter expression on a event field Filter=the actual expression in LTTng

7) Click on 'Ok" 2.8+) RCPTT
Verify that selected event is added

1) Execute 14.3 under the selected channel.

2) Select one UST Tracepoint event under Providers -> <UST

Process> Verify that Properties view shows

3) click right mouse button correct values for this event (Event

4) select menu item ‘Enable Event...
5) Select newly create session and channel
6) Enter filter expression on a event field

Type=TRACEPOINT,
State=ENABLED, Filter=with filter,
Filter=the actual expression in LTTng

7) Click on 'Ok’ 2.8+) RCPTT
1) Start Tracing

2) Stop Tracing after a view seconds

3) Import Trace to Project Make sure that only events are shown

4) Open Trace in the events table that met the

5) Destroy Session condition in the filter expressions Manual

For the tests below a Ubuntu machine with LTTng 2.1 installed

(with Ittng tools 2.1.x) is required. Either create a VM machine

yourself (e.g. on Virtualbox) or install it locally on your native

Ubuntu (if correct version). Make sure that the root session

daemon is running (sudo Ittng list -k) and have one UST

process running (e.g. from Ittng-tools git repository under

tests/hello.cxx)
After 2) verify that advanced options
are shown (e.g. Trace Path, Protocol,
Address and Port)

After 3) verify that advanced option are

1) Open Create Session Dialog box not shown and only basic options are
2) Select "Advanced >>>" there (Session Name and Session
3) Select "<<< Basic" Path) RCPTT

After 2) verify that data Protocol and

data Address is enabled. Note that the

ports cannot be configured for net and
1) Open Create Session Dialog box and select "Advanced >>>" net6 when this button is unchecked. ->
2) Uncheck checkbox"Use same protocol and address for data  port text fields are disabled

and control"
3) Check checkbox "Use same protocol and address for data After 3) Verify that data Protocol and
and control" data Address are disabled RCPTT

1) Open Create Session Dialog box and select "Advanced >>>" Verify that the Control protocol
dropdown menu shows net, net6 and
file RCPTT

1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data After 2) verify that the data protocol
and control" dropdown menu shows net, net6, tcp
and tcp6 RCPTT
After 2) verify that net6 is propagated
to the data protocol and and that the
data and control port text fields are

enabled
1) Open Create Session Dialog box, select "Advanced >>>"  After 3) verify that file is propagated to
2) Select net6 for Control Protocol the data protocol and that the data and
3) Select file for Control Protocol control port text fields are disabled. RCPTT
1) Open Create Session Dialog box, select "Advanced >>>"  After 2) verify that the IP address is
2) Enter IP address in Control address propagated to the data address field ~ RCPTT
1) Open Create Session Dialog box and select "Advanced >>>"
2) Uncheck checkbox "Use same protocol and address for data
and control"
3) Select tcp for control protocol and tcp6 for data protocol
4) Check checkbox "Use same protocol and address for data
and control" After 4) make sure that both data and
control protocol show net RCPTT

LTTng 2.0 - Control
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15.9

15.10

15.11

15.12

15.13

15.14

1) Open Create Session Dialog box and select "Advanced >>>"
2) Enter session name, select file protocol and enter directory
/tmpltestTraces/ in address field and press ok

3) Enable events, start tracing, wait for a few seconds, stop

tracing
Create trace with file 4) Import traces to a existing tracing project
protocol 5) Destroy session

1) Open Create Session Dialog box and select "Advanced >>>"
2) Enter session name, select file protocol and enter directory
Itmp/tmpTraces/ in address field, enter /newPath in "Trace
Path" text field and press ok
3) Enable events, start tracing, wait for a few seconds, stop
tracing

Create trace with file ~ 4) Import traces to a existing tracing project

protocol and trace path  5) Destroy session

1) Start relayd on Eclipse local machine (default settings: lttng-
relayd)

2) Open Create Session Dialog box and select "Advanced >>>"
3) Enter session name, select net protocol and enter IP address
of Eclipse local machine in address field and press ok

4) Enable events, start tracing, wait for a few seconds, stop

tracing
Create trace with net 5) Import traces to a existing tracing project
protocol 6) Destroy session

1) Uncheck checkbox "Use same protocol and address for data
and control"

2) Start relayd on Eclipse local machine with specified ports
(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp:/0.0.0.0:5678)

3) Open Create Session Dialog box and select "Advanced >>>"
4) Enter session name, select tcp protocol and enter IP address
of Eclipse local machine in address field, specify data and
control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop

tracing

Create trace with tcp 6) Import traces to a existing tracing project

protocol and port 7) Destroy session
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced >>>"

4) Enter session name, select net protocol and enter IP address

of Eclipse local machine in address field, keep defaults for Live

Connection and Live Delay, and press ok

5) Enable UST events (per UID channel), start tracing, wait for a
Live Streaming Session few seconds, stop tracing

(UST) - Initial 6) Import traces to a existing tracing project

implementation 7) Destroy session
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced >>>"

4) Enter session name, select net protocol and enter IP address

of Eclipse local machine in address field, keep defaults for Live

Connection and Live Delay, and press ok

5) Enable Kernel events, start tracing, wait for a few seconds,
Live Streaming Session stop tracing

(Kernel) - Inititial 6) Import traces to a existing tracing project
Implementation 7) Destroy session
Preferences

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Open Preference Dialog Tracer Control Preferences)

Verify that the traces are stored on the
remote host under
ItmpltestTraces/kernel and
ItmpltestTraces/ust/<application(s)>
repectively.

After 2) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

Verify that the remote import dialog

box opens at step 4 (as described in

test cases 11.x) and it is possible to

transfer the traces to the tracing

project. RCPTT Need a human to fully test
Verify that the traces are stored on the

remote host under

ItmpltestTraces/newPath/kernel and

ItmpltestTraces/newPath/ust/<applicati

on(s)> repectively.

After 3) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

Verify that the remote import dialog
box opens at step 4 (as described in
test cases 11.x) and it is possible to
transfer the traces to the tracing
project. RCPTT Need a human to fully test
Verify that the traces are stored on the
Eclipse local machine under
/home/<user name>/Ittng-
traces/<remote machine
name>/<session name + date>/kernel
and /home/<user name>/lttng-
traces/<remote machine
name>/<session name +
date>/ust/<application(s)> repectively.

After 3) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

After 5) Verify that dialog box for
selecting a tracing project is openend
that after selecting a project and
pressing next the default trace import
wizard opens. Then verify that it is
possible to transfer the traces to the
tracing project. Manual Verified in Aug. 22-2018 at 12:03PM
Verify that the traces are stored on the
Eclipse local machine under
/home/<user name>/Ittng-
traces/<remote machine
name>/<session name + date>/kernel
and /home/<user name>/lttng-
traces/<remote machine
name>/<session name +
date>/ust/<application(s)> repectively.

After 4) make sure that the Session
Path in the Property View shows the
URL with the configured parameters

After 6) Verify that dialog box for
selecting a tracing project is openend
that after selecting a project and
pressing next the default trace import
wizard opens. Then verify that it is
possible to transfer the traces to the

tracing project. Manual Verified in Aug. 22-2018 at 12:03PM

Verify that session is created
successfully. Verify that after 6) the
trace appears in the Traces directory
of Remoter project. Verify that
relevants views are updated when new

data arrives SWTBot Implementation disabled for 2.0

Verify that session is created

successfully. Verify that after 6) the

trace appears in the Traces directory

of Remoter project. Verify that

relevants views are updated when new

data arrives SWTBot

Implementation disabled for 2.0

Verify that tracer control preferences

exists and shows Tracing Group,

Logging, Log File (always disabled),

Append, Verbose Level (None, Level

1, Level2 Level 3) RCPTT

LTTng 2.0 - Control
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16.2

16.9

16.10

16.11

Enable Logging

Disable Logging

Test Logging level none

Test Verbose Logging
(Level 1)

Test Verbose Logging
(Level 2)

Test Verbose Logging
(Level 3)

Append Mode

Change Tracing Group

Change execution
timeout

Reset

Create Channel with
advance features
(LTTng 2.2 features)

Configure Metadata
channel (kernel)

Configure Metadata
channel (UST)

Configure File rotation
(kerel)

Configure File rotation
(ust)

Buffer Type - toggle
UST/kernel

Default UST Buffer Type

In Tracer Control Prferences, check checkbox Logging
In Tracer Control Prferences, uncheck checkbox Logging

Execute 16.2 and execute some commands (e.g. create

session, enable event)

1) Execute 16.2
2) select verbose level Level 1

3) Execute some commands (e.g. create session, enable event)

1) Execute 16.2
2) select verbose level Level 2

3) Execute some commands (e.g. create session, enable event)

1) Execute 16.2
2) select verbose level Level 3

3) Execute some commands (e.g. create session, enable event)

Check checkbox Append, restart Eclipse and open Tracer

Control Preferences

Change Tracing group (e.g. tracing2) and execute a command

(while logging enabled)

Go to Remote Connection Preferences, Change Timeout

Reset to defaults

For the tests below a Ubuntu machine with LTTng 2.2 installed
(with lting tools 2.2.x) is required. Either create a VM machine.
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under

tests/hello.cxx).

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel..."

3) Select Checkbox 'Configure metadata channel'

4) Update all text boxes
5) Click on 'Ok’

1) Re-do 17.2 with a UST channel

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel..."
3) Fill in channel name

4) Fill in 1048576 in 'Maximum size of trace files' and also 'Sub

Buffer Size'

5) Fill in 2 in 'Maximum number of trace files'

6) Click on 'OK'
7) Enable all kernel events
8) Start, wait and stop tracing.

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel..."
3) Fill in channel name
4) Select UST

5) Fill in 262144 in 'Maximum size of trace files' and also 'Sub

Buffer Size'

6) Fill in 2 in 'Maximum number of trace filesfiles"

7) Click on 'Ok’
8) Enable all UST events
9) Start, wait and stop tracing.

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel..."
3) Select UST

4) Select Kernel

5) Slect cancel

1) Create and select session and click right mouse button

2) Select menu item 'Enable Channel..."
3) Select UST

4) Enter Channel Name

5) Select 'Ok’

Verbose Level radio buttons will be
enabled

Verbose Level radio buttons will be
disabled

Make sure that log file is created and
contains the executed commands and
command replies

Make sure that log file contains the
executed commands with -v option (e.
g. lttng -v create session) and the
command replies come with debug
information

Make sure that log file contains the
executed commands with -vv option
(e.g. lttng -vv create session) and the
command replies come with debug
information

Make sure that log file contains the
executed commands with -vvv option
(e.g. Ittng -vvv create session) and the
command replies come with debug
information

Verify that tracer control preferences
are persisted and the log file is opened
in append mode (old file is not
overwritten)

Verify that Ittng command is executed
with command line option -g <group>.
Ignore any command reply errors (if
any)

After verify that values smaller than 5
and bigger than 600 are rejected
Verify: Group=tracing, Logging is
deselected, Append is deselected,
Verbose Level=None), and Command
Timout is 15

Verify after 3) that '‘Channel Name' is
set to metadata and the correspondig
textbox is disabled. Verify after 5) that
metadata channel was created under
the kernel domain. Also verify in the
properties view that all parameters are
set correctly when selecting the
channel metadata.

Verify after 3) that 'Channel Name' is
set to metadata and the correspondig
textbox is disabled. Verify after 5) that
metadata channel was created under
the domain UST global. Also verify in
the properties view that all parameters
are set correctly when selecting the
channel metadata.

After 8) verify on the trace node that
trace files are not bigger than 1048576
bytes

After 9) verify on the trace node that
trace files are not bigger than 262144
bytes

Verify after 2 and 4 that the radio
buttons for the buffer type is disabled
and the buffer type "Global shared
buffers" is selected which is the value
for the kernel tracer.

Verify after 3) that the radio buttons
are enabled an no buffer type is
selected

Verify after 5) that the default buffer
type is configured for that channel (see
properties view). Note for LTTng Tools
2.2 the default is per-PID and for
LTTng Tools 2.3 and later it is per-UID

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

RCPTT

This makes no difference for MI starting with Lting 2.6

This makes no difference for MI starting with Lttng 2.6

This makes no difference for MI starting with Lttng 2.6

Command is successful. However tracer doesn't create
metadata channel. Bug in LTTng http://bugs.Ittng.
orglissues/994

Need a human to check the size on the host

Need a human to check the size on the host

LTTng 2.0 - Control
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Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."

3) Select UST

4) Select 'Per PID buffers'
5) Enter Channel Name Verify after 6) that the per-pid buffer
6) Select 'Ok’ type is configured for that channel (see
8) Enable all ust events properties view). After 10) make sure
per PID UST Buffer 9) Start, wait and stop tracing. that for each UST application one
17.8 Type 10) Import trace trace is created RCPTT 9) and 10) not tested with RCPTT

Prequisite: Multiple UST Applications need to run
1) Create and select session and click right mouse button

2) Select menu item ‘Enable Channel...’

3) Select UST

4) Select 'Per UID buffers'

5) Enter Channel Name Verify after 6) that the per-pid buffer

6) Select 'OK' type is configured for that channel (see
8
9

1

properties view). After 10) make sure

Enable all ust events Wil doing this | found a e bugs bt t anded up woring See

and https:

per UID UST Buffer Start, wait and stop tracing. that only one trace is created even /Ibugs.eclipse. /_bug.
17.9  Type 0) Import trace multiple UST applications are running. ~ RCPTT 9) and 10) not tested with RCPTT
‘Snapshot Channel
18 (LTTng 2.3 features)
Preparation Connect to a node with LTTng 2.3 installed
Verify that new session is added under
the Session tree node. Verify
properties in Properties view (by
selecting the session in the Control
view):
'Session name' (=MySession)
'Snaphshot ID' (:
'Snapshot Name' napshot-1)
'Session Path'
(=/home/<user>/traces/MySession_<d
1) Click right mouse button on 'Sessions' ate and time>) and 'State’
2) Select 'Create Session..." in the context sensitive menu (=INACTIVE)
3) Enter session name 'MySession', keep 'Session Path’ empty
Create Snapshot 4) Select checkbox 'Snapshot Mode' Make sure that the button and menu
18.1  Session 5) Select 'Ok item 'Record Snapshot' is enabled RCPTT
Verify that channel and events a
18.2 Enable Kernel Event Enable all Kernel Tracepoint and syscall events successful enabled RCPTT

Verify that Session icon changes to
'ACTIVE' icon. Verify that property
view shows 'ACTIVE' for the session
state

Make sure that the button and menu

item 'Record Snapshot' is enabled.

Also make sure that the Button and

menu item 'Import' is enabled. RCPTT

a) Select session and click on button 'Start'

b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
‘Record Snapshot' and once with context-sensitive menu item
'Record Snapshot'

18.3  Start Session

18.4 Record snapshot ‘Commands succeed without error RCPTT

Create another snapshot Make sure that snapshot session is
18.5  session session name ustSession (as described in 18.1) created successfully RCPTT
Verify that channel and events a
18.6  Enable UST Events Enable all UST events successful enabled RCPTT

18.7 Start UST session see 18.3 see 18.3 RCPTT
Record snapshot over  Select kernel and ust session (see 18.1 and 18.5) and click on

18.8 multiple sessions ‘Record snapshot' button Command succeeds without error RCPTT

Verify that 4 snapshots are available

(3 kernel and 1 UST). Verify that all

snapshots are imported to the selected

189  Import traces Open Import dialog (see 11.2) tracing project RCPTT
Stop and destroy Verify that sessions are destroy
18.10  sessions Stop and destroy both sessions successfully RCPTT
1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Open Create Session Dialog box, select 'Snapshot Mode'and

select "Advanced >>>"

3) Enter session name, select net protocol and enter IP address

of Eclipse local machine in address field and press ok

4) Enable events (UST and Kernel), start tracing, and recorda  Make sure that all steps were

few snapshots, stop tracing successfull. Also, import the traces

5) Import traces to a existing tracing project using the standard import instead of

6) Destroy session the remote import Manual

Network snapshot
18.11  session Verified in Aug. 22-2018 at 14:45PM
Note that the session has to be started at least once otherwise the
command will ail,

Record snapshot when
18.12  session is inactive SWTBot

19 ‘Command Script
Make sure that each command of
Create a command script to create a session with kernel and script is executed and script execution

- scrip Verified in Aug. 22-2018 at 14:42PM. | will provide a Perl /Python
19.1 Execute command sript  ust events enabled. is without errors Manual i

script in test spec.

20 Session Profiles
Make sure that the session is saved
under ~/.Ittng/sessions on the remote

1) Create Tracing session

2) Select session and click right mouse button
3) Select Menu item "Save...

4) Select 'OK'

Make sure that session is availabe in
the workspace by opening Window-
>Preferences -> Tracing -> LTTng
Remote Profiles
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Make sure that the session is saved
under ~/lttng/sessions.
Make sure that session is availabe the
user is prompted to skip or overwrite
202 Save session (2) 1) Re-do 20.1 (use same session name) the profile in the workspace Manual
1) Re-do 20.1 The save command will be rejected by
203 Save session (no force) but deselect force button LTTng Tools RCPTT

Verified in Aug. 22-2018 at 14:47PM

destroy all sessions
1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select a existing profile (from Local)
4) Select 'OK'
20.4  Load Session (local) Make sure that the session is created ~ SWTBot

destroy all sessions

1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Remote”
4) Select a existing profile (from Remote)
5) Select 'OK'

20.5 Load Session (remote) Make sure that the session is created RCPTT
1) Select group "Sessions" and click right mouse button
2) Select Menu item "Load..."
3) Select "Manag Make sure that the LTTng Remote

20.6 Open preference (1) Profile preference page opens RCPTT
Open Preferences (Menu -> Preferences -> Tracing -> LTTng  Make sure that the LTTng Remote

20.7 Open preference (2) Remote Profiles Profile preference page opens RCPTT
1) Open Preference page (see 20.7)
2) Select multiple profiles
3) Click on "Export..." Make sure profile is exported to the

20.8 Export profile 3) Select destination directory and click on "OK" destination directory Manual

Make sure that user is prompted about

209  Export profile (redo) Redo 20.8 to overwrite or skip existing profile Manual
1) Open Preference page (see 20.7)
2) Click on "Import..." Make sure profile is imported and

20.10  Import profile 3) Select a profile on media and click on "OK" available in workspace Manual
1) Redo 20.8 Make sure that user is prompted about

20.11  Import profile (redo) to overwrite or skip existing profile Manual

1) Open Preference page (see 20.7)
2) Select multiple profiles
3) Click on "Delete..." Make sure profile(s) are delete from
20.12  Delete profile 3) Confirm deletion the workspace and disk RCPTT

Kernel Event Filtering
21 (LTTng 2.6)
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.6.x) i required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo Ittng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
211 tests/hello.cxx)
1) Connect to remote host
21.2 Preparation 2) Create new Session 'FilterSession’
Verify that default channel (channel0)
is create under domain 'Kernel' and
that the corresponding event is
created under the channel with state
ENABLED.
1) Select session and click right mouse button
2) Select menu item 'Enable Events (default channel)...! Verify that Properties view shows
3) Select 'Kernel' correct values for this event (Event
4) Select Radio button for "Tracepoint Events' Type=TRACEPOINT,
5) Select one tracepoint State=ENABLED, Filter=with filter,
Enable Kernel Event on  6) Enter filter expression on a event field Filter=the actual expression in LTTng
213 session level 7) Click on 'Ok’ 2.8+) SWTBot
Verify that selected event is added
under the selected channel.
1) Execute 14.3
2) Select one Kernel Tracepoint event under Provider "Kemel"  Verify that Properties view shows
3) click right mouse button correct values for this event (Event
4) select menu item 'Enable Event..." Type=TRACEPOINT,
5) Select newly create session and channel State=ENABLED, Filter=with filter,
Enable Kernel Event 6) Enter filter expression on a event field Filter=the actual expression in LTTng
214 from provider 7) Click on 'Ok' 2.8+) SWTBot
1) Start Tracing
2) Stop Tracing after a view seconds
3) Import Trace to Project Make sure that only events are shown
4) Open Trace in the events table that met the
215 Create trace 5) Destroy Session condition in the filter expressions Manual

Verified in Aug. 222018 at 14:54PM

LTTng UST Exclude
22 events (LTTng 2.5)
For the tests below a Ubuntu machine with Ittng tools 2.5.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo Ittng list -k) and have one UST process running (e.g. from

221 Ittng-tools git repository under tests/hello.cxx)
1) Connect to remote host
222 Preparation 2) Create new Session 'FilterSession’
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223

23

Enable events with
exclude

LTTng UST per syscall
(LTTng 2.6)

Preparation

Enable selected syscalls

destroy session

Enable all syscalls

JUL, Log4J, Python
Logger

Configure JUL tracing
session (LTTng 2.6)
Configure Log4J tracing
session (LTTng 2.6)
Configure Python tracing
session (LTTng 2.7)

1) Open Enable Event Dialog, select UST
2) Use wildcards
3) Enter a event name to exclude

For the tests below a Ubuntu machine with Ittng tools 2.6.x is
required. Either create a VM machine yourself (e.g. on
Virtualbox) or install it locally on your native Ubuntu (if correct
version). Make sure that the root session daemon is running
(sudo lttng list -k) and have one UST process running (.g. from
Ittng-tools git repository under tests/hello.cxx)

1) Connect to remote host

2) Create new Session 'MySession'

1) Open Enable Event Dialog, select Kemel

2) Select syscalls

3) In the tree, select selected syscalls

4) Select Ok

1) Open Enable Event Dialog, select Kemel
2) Select Syscalls

3) In the tree, select all syscalls

4) Select Ok

Configure JUL tracing session
using tree and event name
Configure Log4J tracing session
using tree and event name
Configure Python tracing session
using tree and event name

Verify that event is added under the
UST Domain and relevant channel.
Verify that the Properties view shows
the exclusion: Exclusion=with
Exclusion, for Exclusion the actual
expression in LTTng 2.8+

Verify that the selectetd syscalls are
added added under the Kernel Domain
and relevant channel.

Verify that the selectetd syscalls are
added added under the Kernel Domain
and relevant channel.

verify that session is configured
correctly
verify that session is configured
correctly
verify that session is configured
correctly

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

SWTBot

LTTng 2.0 - Control
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Section
Tracing RCP

Target: Ubuntu 16.04 64 bit

Step

0

1

1.1

1.2

1.3

1.4

1.5

1.6

1.7

1.8

2.1

Test Case
Preparation

Start RCP

Start Tracing RCP

Start Tracing RCP with text trace

Action

Open RCP from command
line or file explorer

Open RCP from command line
with --open <trace name with
absolute path>

Open RCP from command line
with --open <trace name with

Start Tracing RCP with previously absolute path>. Use same trace

opened text trace

Start Tracing RCP with Kernel
CTF trace

opened Kernel CTF trace

Start Tracing RCP with new trace
with name conflict

Re-do 1.6

Start Tracing RCP with non-trace
file

File menu

Open Trace (File)

than 1.2

Open RCP from command line

Verification

Tracing RCP opens in default perspective

Trace will be opened with auto-detected
trace type

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Tracing RCP is opened, the trace is linked

with --open <kernel trace name to the Tracing project, the kernel analysis

with absolute path>

Open RCP from command line

trace type is selected and trace is opened.

with --open <kernel trace name Verify that the same trace that was
Start Tracing RCP with previously with absolute path>. Use same

trace than 1.4

Open RCP from command line
with --open <trace name with
absolute path>, where the
name of trace is the same than
1.2, but the trace is located at a
different location on disk

Open RCP from command line
with --open <kernel trace with
absolute path>, where name of
trace is the same than 1.4, but
the trace is located at a
different location on disk

Open file that is not a trace

Use Menu "File -> Open Trace
..." In the file dialog select a
text trace and select open.

previously linked into the Traces folder is
opened and not a new trace entry is created

Verify that a new trace is linked to the
Tracing project and trace is opened. Verify
that the new trace name has a integer
number a suffix added.

Verify that a kernel trace is linked to the
Tracing project, the kernel analysis trace
type is selected and trace is opened. Verify
that the new trace name has a integer
number a suffix added.

Trace is imported (linked) however default ic

Trace will be opened with auto-detected
trace type

To Do

Comment

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Comment

The delete key doesnt work on
Tracing project (we need to use the
mouse right click). Bug 486505.

The kernel trace opens in an editor
but the editor of the first trace gets
activated. Bug 443461.

Same bug happens with UST
traces

RCP
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22

2.3

2.4

2.5

2.6

2.7

2.8
2.9

3.1

32

33

3.4

Open Trace (File) with previously

opened text trace

Open Trace (Directory)

Open Trace (Directory) with
previously opened Kernel CTF
trace

Open Trace File with name
conflict

Re-do 2.5

Open file

Restart
Exit

IWindow Menu

Open Perspective

Open View

Preferences

Save Perspective As

Use Menu "File -> Open
Trace...". In the file dialog
select a text trace and select
open. Use same trace than 2.1

Use "Menu File -> Open Trace
..." . In the file dialog select a
file of Kernel CTF trace
directory and select open.

Use "Menu File -> Open Trace
..." . In the file dialog select a
file of Kernel CTF trace
directory and select open. Use
same trace than 2.3

Use Menu "File -> Open Trace
..."" In the file dialog select a
text trace and select open,
where the name of trace is the
same than 2.1, but the trace is
located at a different location
on disk

Use "Menu File -> Open Trace
..."" . In the file dialog select a
file of Kernel CTF trace
directory and select open,
where the name of trace is the
same than 2.3, but the trace is
located at a different location
on disk

Open file that is not a trace

Use Menu File -> Restart
Use Menu File -> Exit

Use Menu Window -> Show
Perspective -> Tracing
Perspective

Use Menu Window -> Show
View -> Select Tracing ->
Sequence Diagram

Use Menu Window ->
Preferences

Make changes of perspective
by moving views and use menu
Window -> Save Perspective
As. Enter a perspective name
and select Ok

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Verify that the trace is linked to the Tracing
project, the kernel analysis trace type is
selected and trace is opened.

Verify that the same trace that was
previously linked into the Traces folder is
opened and not a new trace entry is created

Verify that the new trace is linked to the
Tracing project and the trace is opened.
Verify that the new trace name has a integer
number a suffix added.

Verify that the kernel trace is linked to the
Tracing project, the kernel analysis trace
type is selected and trace is opened. Verify
that the new trace name has a integer
number a suffix added.

Trace is imported (linked) however default ic

Verify that RCP is restarted with the
previously open perspective and trace

Tracing RCP exits

Tracing perspective is opened

Sequence diagram view is shown

Preferences dialog is shown

Perspective with new name is stored

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

RCP
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35

4.1

4.2

4.2

44

4.5

5.1

52

53

54

5.5

6.1

Reset Perspective

Help Contents

Help Contents (shortcut)

Install new Software

About

Version + Copyright

TMF presence

LTTng presence

PCAP Network analysis presence
PcapNg Network analysis

presence

BMF presence

Upgrade from previous release

Make changes of perspective

by moving views and use menu After confirming the reset operation the

Window -> Reset Perspective.

Use Menu -> Help -> Help
Contents

Use key F1

Use Menu -> Help -> Install
New Software... to install new
Eclipse feature

Use Menu -> Help -> About

Use Menu -> Help -> About ->
Installation details

Open Tracing perspective

Open LTTng Kernel
perspective

Open Network Tracing
perspective
Open Network Tracing
perspective

Open Network Tracing
perspective

Use Help -> Check For
Updates

perspective is reset to the default layout.
Help content browser is opened. All
Tracing related help is included

Help content browser is opened. All
Tracing related help is included

Installation is successful

About dialog is opened all relevent
information (e.g. version, copyright years
etc) is up-to-date and correct.

Go over all tracing features and plug-ins
and verify that all have the correct version
and copyright years

Tracing perspective opens

LTTng Kernel perspective opens
Network analysis perspectiv opens
Network analysis perspectiv opens

Network analysis perspectiv opens

RCP is upgraded

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Tested with RC3

RCP
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Target:

Step

0

0.1

0.2
0.3

21

22

23

Section

Trace Synchronization

Test Case
Prerequisites
Import traces

Create experiment 1
Create experiment 2
View Management

Open Synchronization View
Delete view
Open view

Open Experiment

Synchronize experiment

Open view when trace is
already loaded

Synchronize experiment with
constant offset

Open trace

Re-open experiment

Restart

Functionnalities

Open experiment 2

Go back to previous
experiment

Synchronize experiment

Pass

Action

Import the scp_dest and scp_src traces in

the synctraces.tar.gz file

Create an experiment containing those 2

traces

Create an experiment with any other trace

Use menu Window — Show View — Tracing —

Synchronization

Close the Synchronization View

Use menu Window — Show View — Tracing —

Synchronization

Open the experiment containing the 2

synchronizable traces

Right-click on the experiment and select

'Synchronize Traces'

1) Close Synchronization View
2) Load LTTng experiment
3) Open 'Synchronization' view

Try to offset a trace by a second
Open an Lttng Kernel trace

Open the experiment containing the 2

synchronized traces

Restart Eclipse

Open the experiment containing traces that

do not synchronize

Re-open the experiment with the
synchronizable traces

Right-click on the experiment and select

'Synchronize traces'

Fail

Verification

Verify that 'Synchronization' view
is shown

Synchronization' view is removed
from perspective

Synchronization' view is displayed
and remains empty

Verify that the view is still empty
After a time, the view is populated
with synchronization result that
say 'accurate'. And one of the
original traces has been replace by
a trace with the same name, but
with an'_' at the end.

Verify that view is populated with
synchronization data from
currently opened experiment
Visually verify that a
synchronized trace is now
offsetted

Synchronization view is empty

View shows synchronization data
from the experiment

Verify that view is populated with
synchronization data from
experiment

Verify that the 'Synchronization'
view is empty

Verify that the 'Synchronization'
view contains the data from the
experiment

After the syncronization job
finishes, the synchronized
experiment is closed and
experiment 2 is selected. The
synchronization view is empty.

To Do

Comment

[ o [ o o

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Comment

TraceSynchronization

Simon: not sure what should be the result of this operation
Bernd: | think it is to add a manual time offset on top of the synchronisation
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Section

LTTng 2.0 - Memory
Analysis

Target: Ubuntu 16.04 64 bit

Step

0

0.1

0.2

0.3
0.4

1.1

1.2

1.3

14

1.5

21

22
23

24
25

2.6

3.1

Test Case

Prerequisites

Download traces

Import trace with memory
event

Import trace without
memory event

Import non-UST trace
Project View

Check analysis can
execute

Verify help message when
applicable

Check analysis cannot
execute

Verify help message when
not applicable

Check analysis for another
trace type

View Management
Populate analysis's view
Open view

Close trace

Open trace

Close view

Re-open view

Mouse handling

Drag move time range

Action

Download UST trace with memory events
from https://secretaire.dorsal.polymtl.
ca/~gbastien/traces/eclipse_mem_ust.tar.
gz. Hung: | suggest downloading eclipse
trace

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for

example, the one used for the callstack view

Import one LTTng Kernel trace

open the trace that contains the memory
events. In the project explorer, expand the
trace that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,
right-click the memory analysis and select
Help

open the trace that contains the memory
events. In the project explorer, expand the
UST trace that does not contain memory
events

In the project explorer, open and expand

Verification

"Ust Memory" analysis is present and "normal”

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

the UST trace that does not contain memory The help message mentions the analysis is impossible
events, right-click the memory analysis and to execute and contains the requirement that is not

select Help

In the project explorer, expand a LTTng
Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view
Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

Drag move xy chart left and right with
middle button

fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis

The UST Memory Usage view opens and triggers the
memory analysis. After the analysis, the XY chart is
populated

The UST Memory Usage view is emptied.
The UST Memory Usage view is populated.

The view is closed.

The view opens and is automatically populated.

Time range is dragged. When mouse button is
released, the view refreshes with the new time range

Type

To Do

Type

SWTBot

Manual

Manual

Manual

SWTBot

SWTBot

SWTBot
Manual

SWTBot
Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass
Pass

Pass

Pass

LTTng 2.0 - Memory analysis

Comment

Comment

84702
Verified in Aug. 17-2018 at 15:09PM, but help
message is not helpful
84702
84702
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Zoom time range (mouse

3.2 wheel)

3.3 Drag select time range
3.4 Mouse hover

3.5 Drag mouse selection
3.6 Shift key selection

Drag mouse selection
3.7 (Status bar)

Shift key selection (Status

3.8 bar)
4 Synchronization
Preparation
4.1 Time synchronization
4.2 Time range synchronization
Time range selection
43 synchronisation

Zoom with CTL + mouse wheel up and
down, cursor inside xy chart

Drag select time graph with right button
Hover mouse in xy chart anywhere
Drag select xy chart with left button
Click select with left button (begin time),

press shift key and click select another time
(end time)

Drag select xy chart with left button

Click select with left button (begin time),
press shift key and click select another time

(end time)

Have the Histogram and UST Memory
Usage views both visible

Select a random time in another view
Select a new time range in UST Memory
Usage view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Time range is zoomed in and out, relative to mouse
cursor. When mouse wheel is stopped for a short time,
series are updated and new time range is propagated
to other views.

Selection highlighted. When mouse button is released,
time range is zoomed to selection, series are updated
and new time range is propagated to other views.

Tool tip shows values for each thread at the given
timestamp

Selection highlighted. New selection is propagated to
other views

Selection highlighted. New selection is propagated to
other views

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be
negative)

Selection highlighted. Status bar of Eclipse is updated
with time information: T, T1, T2 and delta, where T is
the time of the mouse position, T1 the first selected
time, T2 the second (draggged) selected time and
delta the time difference between T2-T1 (can be

_negative)

Selected time line is updated.
Time range is updated.

Selection range is highlighted.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

LTTng 2.0 - Memory analysis

When you zoom in and a series was checked but it is
now filtered out, when you zoom out you lose you
checked series
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Section Pass Fail ToDo Comment
Network Trace analysis 10 3 0 0
Target: Ubuntu 14.04 64 bit

Step Test Case Action Verification Comment
0 Prerequisites
0.1 Import traces Import the trace linked here
1 Trace Import
Open the Network Tracing In the project Explorer, expand any LTTng kernel Verify that the events view, the properties and stream list
1.1 perspective trace are displayed SWTBot Pass
The trace is given a "network" icon. When openned, the
1.2 Open trace Double-click on the "TeamSpeak2.pcap" trace events view and histogram view is opened SWTBot Pass In SWTBot other trace is used
2 View management _
2.1 Populate the views Open the "TeamSpeak2.pcap" The views are updated SWTBot [ Pass
One stream is available with endpoint A being 00:0c:29:
22 Look up stream Open the Stream List view Tc:ab:f9 Manual | Pass
2.3 Close the trace Close the trace The stream list is emptied Manual Pass
2.4 Close view Close the Stream List view The view is closed Manual Pass
Open view when trace is The view opens with the correct title and is correctly
2.5 already loaded Re-open the trace. Open The Stream List view populated. Manual | Pass
2.6 Open a non pcap trace Close the trace The stream list is emptied Manual Pass
3 Stream List
3.1 Re-open trace Ensure only "TeamSpeak2.pcap" is opened The trace is opened Manual Pass
Create a filter from the Right click on stream 0, and select "Extract as A filter named "FILTER stream eth 00:0c:29..." is
3.1 stream list Filter" created Manual Pass

In the events table, right click on an event and
select "Apply preset filter-> stream eth 00:0c:
3.2 Apply filter 29.." 24/24 events pass the filter Manual
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Target:

0.1

0.2

0.3

1.1

1.5

2.1

2.2

23

24

2.5
2.6
2.7
2.8
2.9

3.1

3.1

Section
XML analysis
Ubuntu 14.04 64 bit

Test Case

Prerequisites
Import traces

Get a test XML file

Make sure the XML file does
not exists in the project

XML file handling

Verify analysis not present

Import XML file

Edit XML file

Disable XML file

Enable XML file

View management

Populate the views

Open the 'Xml Control Flow
View'

Open another XML view
Close view

Open view when trace is
already loaded

Close traces

Open trace

Open another trace

Open LTTng Kernel trace
View selection

Select an entry in the table

Select entry in time graph

Action

Import LTTng kernel traces

Download the test XML file here: https://secretaire.
dorsal.polymtl.ca/~gbastien/Xml4Traces/Kernel. Linux.
xml

Open the Manage Xml Analyses menu and delete the

XML file if it exists (or The XML files are located in

<workspace directory>/.metadata/.plugins/org.eclipse.
tracecompass.tmf.analysis.xml.core/xml_files. Delete

the linux kernel XML file if it exists.)

In the project Explorer, expand any LTTng kernel trace

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog import the Kernel.
Linux.xml file and close the dialog.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, select Kernel.Linux
and click Edit

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the checkbox
next to Kernel.Linux to disable it and click Apply.

Right-click the Traces folder, select Manage XML
analyses.... In the opened dialog, click on the checkbox
next to Kernel.Linux to enable it and click Apply.

Open an LTTng kernel trace (eg trace2 from the
tracecompass-test-traces repo)

Double-click the "Xml Control Flow View' under the
analysis

Double-click the "Xml Resources View' under the
analysis

Close both XML view

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace

Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Select an entry in the time graph (empty region)

Verification

NOTE: XML haven't files haven't been update to latest Kernel tracepoints and
syscall changes. So, they only work with trace LTTng 2.5 and older

Verify that there is no 'Xml kernel State System' analysis

Verify that the "Xml kernel State System' analysis is now present
under a LTTng kernel trace

Verify that the XML editor opens. The editor should have Design
and Source sub-tabs

Verify that the 'Xml kernel State System' analysis doesn't not
exist under a LTTng kernel trace

Verify that the 'Xml kernel State System' analysis is present
under a LTTng kernel trace

The "Xml kernel State System' analysis should have a + next to it,
expand it and there should be 2 views under it: "Xml Control
Flow View' and 'Xml Resources View'

A view titled 'Xml Control Flow View' should open and it should
look quite similar to the Control Flow View

A view titled 'Xml Resources View' should open and it should
look quite similar to the Resources view's CPU entries. Both
XML views are opened.

The view are closed

The view opens with the correct title and is correctly populated.
The view is emptied.

The view is populated

The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is updated.
Other views are synchronized to selected time.

Type

To Do

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual
Manual
Manual

Manual

Manual

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Comment

Comment

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Dec.

Verified in Aug.
Verified in Aug.
Verified in Aug.
Verified in Aug.

Verified in Aug.
| Verified in Aug.
Verified in Aug.
| Verified in Aug.
Verified in Aug.

Verified in Aug.

Verified in Aug.

XMLanalysis

17-2018 at 11:32AM

17-2018 at 11:33AM

17-2018 at 11:52AM

17-2018 at 13:50PM

18-2018 at 10:32AM

17-2018 at 14:35PM

17-2018 at 14:37PM

17-2018 at 14:37PM

17-2018 at 14:39PM

17-2018 at 14:40PM
17-2018 at 14:02PM
17-2018 at 14:03PM
17-2018 at 14:04PM
17-2018 at 14:04PM

17-2018 at 14:43PM

17-2018 at 14:43PM
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23

4.1

4.2

4.3

44

4.5

4.6

4.7

4.8

4.9

4.10

4.11

5.1

Select state in time graph

Mouse handling

Drag move time range

Zoom time range (mouse

wheel)

Zoom time range (mouse

drag)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shift key selection
Keyboard handling

Keyboard navigation in table

(entry selection)

Select a state in the time graph

Drag move time graph left and right with middle
button

Zoom with CTRL + mouse wheel up and down, cursor
inside time graph

Drag in time graph scale left and right with left button

Scroll with mouse wheel up and down, cursor outside
time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time), press shift

'key and click select another time (end time)

With focus on table, use UP, DOWN, HOME, END
keys

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is released, states are
updated and new time range is propagated to other views.

Time range is zoomed in and out, relative to mouse cursor. When
mouse wheel is stopped for a short time, states are updated and
new time range is propagated to other views.

Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is propagated to
other views.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change. Vertical scroll bar updated.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change.

Selection highlighted. When mouse button is released, time range
is zoomed to selection, states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time, end time,
duration.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between
T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the first selected time, T2 the second
(draggged) selected time and delta the time difference between

'T2-T1 (can be negative)

Selected process is changed. Time graph selection is updated.
Vertical scroll bar updated.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

XMLanalysis

17-2018 at 14:43PM

17-2018 at 14:47PM

17-2018 at 14:48PM

17-2018 at 14:48PM

17-2018 at 14:48PM

17-2018 at 14:48PM

17-2018 at 14:49PM

17-2018 at 14:50PM

17-2018 at 14:50PM

17-2018 at 14:51PM

17-2018 at 14:51PM

17-2018 at 14:51PM

17-2018 at 14:52PM
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52

5.4

6.1

6.2

6.3

6.4

6.5
6.6

6.7

7.1

7.2

7.3

Keyboard navigation in table
(tree expansion)

Keyboard navigation in time

graph (process selection)
Keyboard navigation in time
graph (state selection)

Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Filter Dialog

Filter Processes
Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use press ENTER while parent or child
process is selected

With focus on time graph, use UP, DOWN, HOME,
END keys

With focus on time graph, use LEFT, RIGHT keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button
Click Previous/Next interval button
Click Zoom In/Out button

Open Filter Dialog

1) Open Filter Dialog
2) Deselect several processes

3) Press Ok

Select a random time in another view

Select a new time range in Resources view or in
Histogram view.

In any other view that supports range synchronization,
select a new range.

For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time graph selection is
updated. Vertical scroll bar updated.

Selected process is changed. Table selection is updated. Vertical
scroll bar updated.

Previous or next state is selected. Selected time is updated in
other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new time
range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected interval (process/resource) is changed in table and time
graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to center of time range.
States are updated and new time range is propagated to other
views.

Verify that all buttons are working correctly

Verify that only selected entries are displayed in the view

Selected time line is updated. If selected time is outside current
range, time range is updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time range
is outside the current range, then time range is updated to include
it

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual
Manual

Manual

Manual

Manual

Manual

Verified in Aug.

Verified in Aug

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.
Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

Verified in Aug.

XMLanalysis

. 17-2018 at 14:52PM

. 17-2018 at 14:52PM

17-2018 at 14:53PM

17-2018 at 14:55PM

17-2018 at 14:55PM
17-2018 at 14:55PM

17-2018 at 14:56PM

17-2018 at 14:56PM
17-2018 at 14:56PM

17-2018 at 14:57PM

17-2018 at 14:57PM

17-2018 at 14:57PM

17-2018 at 14:59PM
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Target:

Step

0

0.1

0.2

0.3

1.1

1.2

1.3

1.4

Section
Critical path

Test Case

Prerequisites

Import traces

Action

Import the 3
django traces from
the test traces
Create an
experiment with

Create experiment the 3 traces in it

Synchronize
experiment

View
management

Open trace

Open experiment

Open view

Close view

Synchronize the
experiment, it
should be
accurate and 2 of
the traces will be
udpated

Open any of the
django traces in
Project Explorer

Open the django
experiment in
Project Explorer

Expand the Views
element, then the
Critical Path
analysis and click
on the Critical
Flow View

Close the Critical
Flow View

Verification

Expand the Views element under the trace.
The OS Exec Graph analysis is there and
"normal". The Critical Path analysis is there
and the Critical Flow view is available under
it.

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
there and "normal". The Critical Path
analysis is there and the Critical Flow view
is available under it.

Critical Path view is opened and empty

Critical Path view is closed

Critical Path

Comment

Manual

Manual

SWTBot

Manual

Comment

Verified in Aug. 17-
Pass 12018 at 10:33AM

Pass

Pass

Pass
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1.5

1.6

2.1

22

23

24

25

Unapplicable trace

Unapplicable

experiment

View population

Populate the view
with trace

Select worker in
time graph
Select state in

time graph

Select worker in
tree viewer

Populate the view
with empty path

Open a trace that
isnotalLTTng
kernel trace

Open an
experiment that
does not contain
LTTng kernel

traces

With the django-
client trace and
the critical path
view opened, in
the control flow
view, find the
process named

python (TID 9496).

Right-click on the

process and select

"Follow
python/9496"

Select an empty
region in the time
graph section

Select a state in
the time graph

Select a worker
from the tree
viewer section

Repeat steps of
2.1, with django-
client trace and
process lttng-
sessiond (TID
9355)

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
not there. The Critical Path analysis is there
and the Critical Flow view is available under
it.

Expand the Views element under the trace.
The LTTng Kernel Exec Graph analysis is
there, but striked out. The Critical Path
analysis is there and the Critical Flow view

is available under it.

The LTTng kernel exec graph is executed
and at the end, the critical path view shows
the interaction between 3 workers.

Same process is highlighted in table.
Selected time line is updated. Other views
are synchronized to selected time.

Same process is highlighted in table. State
is highlighted in time graph. Selected time
line is updated. Other views are
synchronized to selected time.

Same process is highlighted in time graph.

The Critical Path View is emptied

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Critical Path
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255

2.6

2.7

2.8

3.1

3.2

3.3

3.4

Select again

Re-opening

Populate the view
with experiment

Populate with
trace with time

selection

Mouse handling

Drag move time
range

Zoom time range
(mouse wheel)

Zoom time range
(mouse drag)

Mouse vertical
scroll

Repeat steps of
2.1, and select

python/9496 again

Close the django-
client trace,
reopen it and
repeat steps of 2.1

Repeat steps of
2.1, but with the

django-experiment

instead

Re-open django-
client trace. In the

Control Flow View,

select a time after
the python
process exited,
then follow the
python/9496

process

Ctrl-Drag move

time graph left and

right with middle
button

Zoom with mouse
wheel up and
down, cursor
inside time graph
while holding the
Ctl button

Drag in time graph

scale left and right
with left button

Scroll with mouse
wheel up and
down, cursor

The critical path should be the same as 2.1

The Critical Path View should be populated
like in step 2.1

The LTTng kernel exec graph is executed
and at the end, the critical path view is
populated with elements from the 3 traces.

The Critical Path View should be populated

like in step 2.1

Time range is dragged. When mouse button
is released, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is
stopped for a short time, states are updated
and new time range is propagated to other
views.

Time range is zoomed in and out. When
mouse button is released, states are
updated and new time range is propagated
to other views.

Table and time graph scroll up and down
and remain aligned. Selected worker does

outside time graph not change. Vertical scroll bar updated.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Critical Path
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3.5

3.6

3.7

3.8

3.9

3.10

3.11

4.1

4.2

Vertical scroll bar

Drag select time
range

Double-click reset
time range

Mouse hover
(empty region)

Mouse hover
(state)

Drag mouse
selection

‘Shift key selection

Keyboard
handling

Keyboard
navigation in table
(process selection)

Keyboard
navigation in table
(tree expansion)

Click and drag
vertical scroll bar

Drag select time
graph with right
button
Double-click left
button on time
scale

Hover mouse in
time graph over
empty region
Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button (begin
time), press shift
key and click
select another

‘time (end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on table,

in Windows use LEFT,
RIGHT keys while trace
or worker is selected

in Linux use SHIFT
LEFT, RIGHT keys while
trace or worker is
selected

Table and time graph scroll up and down
and remain aligned. Selected process does
not change.

Selection highlighted. When mouse button
is released, time range is zoomed to
selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Tool tip shows process name and PID.

Tool tip shows worker name, state name, priority, date,
start time, end time, duration.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time
difference between T2-T1 (can be negative)

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time
of the mouse position, T1 the first selected time, T2 the
second (dragged) selected time and delta the time

_difference between T2-T1 (can be negative)

Selected process is changed. Time graph
selection is updated. Vertical scroll bar
updated.

For trace, tree is expanded or collapsed. Time graph item
expansion is updated. Vertical scroll bar updated. For
workers, it does nothing.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Critical Path
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4.3

4.4

5.1

5.2

5.3

54

5.5

5.6

5.7

5.8

5.9

Keyboard
navigation in time
graph (process
selection)

Keyboard
navigation in time
graph (state

‘selection) _
Tool bar handling

Align views

Show Legend

Reset Time Scale

Select
Previous/Next
Event

Select Previous/Next
Element

Zoom In/Out

Add Bookmark

Next/Previous marker

Delete bookmark

With focus on time
graph, use UP,
DOWN, HOME,
END keys

With focus on time
graph, use LEFT,
RIGHT keys

Click on the Align View
Button, with another time
graph view, eg the
Control Flow view
opened above or under

Click Show
Legend button

Click Reset Time
Scale button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Click Zoom In/Out
button

Select a time, and click
on the Add Bookmark
button

Add more bookmarks,
then click on the
next/previous marker
buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark button

Selected worker is changed. Table selection is updated.
Vertical scroll bar updated.

Previous or next state is selected. Selected

‘time is updated in other views.

When it is pressed, moving the line between tree viewer
and time graph will move the line of the other view. If not
pressed, the line can be moved without affecting the other
views

The legend dialog is opened and can be

closed.

Time range is reset to full range, states are
updated and new time range is propagated
to other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected worker is changed in table and
time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of selection or window. States are
updated and new time range is propagated
to other views.

The bookmark is added and is displayed in the other views
as well (if enabled)

The time graph view navigate between the bookmarks,
States are updated and time selection is propagated to
other views. When on a bookmark, the Add bookmark
buttons changes to Delete bookmark

The bookmark is deleted from all views

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Critical Path
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5.11
5.12

6.1

6.2

6.3

Do not show markers

_Show markers

Synchronization

Time
synchronization

Window range
synchronization

Selection range
synchronization

Click on the down arrow
at the extreme right of
the view, then expand
Show markers and
uncheck the Bookmarks
box

Same as above, recheck
_the Bookmarks box

Select a random
time in another
view

Select a new window
range in another view
In any other view
that supports
selection range
synchronization,
select a new
range.

With a critical path

displayed, select a
time in another view

that is not in the range

of the process being

displayed in the critical
6.4 Out of region selection path view

All remaining bookmarks disappear from the view, but
remain in other views where the they are enabled

_The bookmarks come back

Selected time line is updated. If selected
time is outside current range, time range is
updated to include it.

Window range is updated.

Selection is highlighted. If the left time (T1)
of selected time range is outside the current
range, then window range is updated to
include it

Selected time is updated and the critical path view is
synced with the other

Manual

Manual

Manual

Manual

Manual

Manual

Critical Path
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Target: Ubuntu 16.04 64

Step

0
0.1

0.2

2.1

22
23
2.4

2.5

3.1
3.2
3.3

Section
LAMI

Test Case

Prerequisites
Import traces
Download analysis
stubs

Custom
external
analysis

Add all stubs
analysis

Actions availables

Actions avaliables
Delete analysis

Run analysis
Reports

Reports node

Same name report
Delete node

Open a report
Open the same

report again
Multiple report
Result Table
Prerequisites
Hide table
Show table

any trace since we use stub for the result

https://bugs.eclipse.org/bugs/attachment.cgi?id=263946
from bug: https://bugs.eclipse.org/bugs/show_bug.cgi?
id=493941

Create the following analysis ($name, $command):

analysisEmpty, analysisEmpty

analysisMultipleRow, analysisMultipleRow
analysisMultipleSimilarRow, analysisMultipleSimilarRow
analysisOneRow, analysisOneRow

multipleReports, multipleReports

invalidAnalysis, invalidAnalysis

errorResult, errorResult

clone, analysisOneRow

Right click on "External Analyses" node
Click the "add" action
Insert $name

Insert "fullpath/$executable” which is the full path to the stub

executable.

ex:"/tmp/stub/stubAnalysis" where stubAnalysis is the stub
executable

The path do NOT support ~ or relative path

Right click on a non-strikethrough custom analysis.

Right click on a strikethrough custom analysis.

Right click on the tuple (clone, invalidAnalysis)
Select the delete action for the node

Launch remaining analysis via righ-click and run action

Expand the "Reports" node under the Project Explorer

Execute the "analysisOneRow" analysis again.

Right click on the duplicate "analysis OneRow" node and click

on the delete action
Right click on any report and select the "open" action
Right click again on the same report to open it

Open the "multipleReports” report.

Open the "analysisMultipleRowReport"

Click the "Toggle" button in the right corner of the result table
Click the "Toggle" button in the right corner of the result table

Verification

All new external analysis are present under the "External
Analysis" node in the Project explorer view.

All new elements do NOT have the strikethrough text
style applied

EXCEPT for the tuple (invalidAnalysis, invalidAnalysis)

Manual
The run action can be clicked and in enabled text mode. Manual
The run action CANNOT be clicked and is in disabled text Manual

The analysis does not appear in the list anymore. Manual

analysisEmpty should return a message to the user regarding the emptiness ¢
errorResult should return an error message to the user and display the result ¢
All other one have result and should result in a new table and new report node

The "Reports" node under the Project Explorer should contain

4 report:

analysisMultipleRow Report

analysisMultipleSimilarRow Report

analysisOneRow Report

multipleReports Manual
An additional node should be present under the "Reports"

node:

analysisOneRow Report #2

Note: This behaviour is subject to change in the following
year but still an action will be taken on same name report

creation. Manual

The node reports is not present anymore Manual

A new panel should open with the result table of the

analysis Manual

A new panel should open with the result table of the

analysis Manual

Validate that a user is able to navigate between sub tab

of a report Manual
Manual

The result table is hidden Manual

The result table is shown Manual

Comment

Comment

Lami
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3.4
3.5

3.6

4.1
4.2

4.3

44

45

46

4.7

4.8

49

4.10

5.1

5.2
53
5.4
55

5.6
5.7

Sorting
Colum Resizing

Multiple selection

Unselect selection
Bar Chart

Create

Series dialog add

Series dialog
remove

Creat chart
Selection
Multi selection

Deselection

Y axis

Keep the chart
open

Hide the table
results

Scatter Chart
Create

Creat chart
Selection
Multi selection
Deselection

Mouse hovering
Full deselection

Sort all column by clicking on the column name. Clicking
multiple time on the name should change the ordering sorter.

Resize the column

Select multiple rows by holding ctrl and clicking on multiple
unselected rows of the table

Deselect multiple rows by holding ctrl and clicking on multiple
selected rows of the table

Use the menu on the upper right of the result table and select
"create bar chart"
Select any x and any y click add

Remove all newly created series via the delete button

Select any x and y and click add and "ok"
Click on any bar inside the chart
Ctrl+click on other unselected bar
Citrl+click on other selected bar

Recreate the same graph but with the y log scale option
enabled

Keep the chart open

Hide the table results

Use the menu on the upper right of the result table and select
"create scatter chart"

Select any x and y and click add and "ok"

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

Hover mouse in the graph
Click in the chart when no hovering cross is present

Validate that the order make sense
Validate that the resize works

Multiple selections are highlighted in the table

The clicked row should not be selected anymore

Note: a bar chart does NOT perform agregation of
categories values

Series are added to the series list

User should be able to delete series

A bar chart should be created
Note: a bar chart does NOT perform agregation of
categories values

The corresponding row should be selected in the table
and the chart should highlight the selected bar

Selections should be highlighted in the result table and
the chart

The clicked bar should be removed from selection and
the result table update with the current selections

Y axis should be in log scale mode
Note: check for zero value and negative handling since
log scale do not support zero and negative

A scatter chart should be created

Should be the same behaviour as the bar chart
Should be the same behaviour as the bar chart

Should be the same behaviour as the bar chart

On mouse hovering a cross should snap to the nearest
point

Al selected objects should be deselected

Manual
Manual

Manual

Manual

Manual

Manual

Manual
Manual
Manual

Manual

Manual
Manual

Manual

Manual
Manual
Manual
Manual

Manual
Manual

Lami
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Section

LTTng 2.0 - I/O
Analysis

Target: Ubuntu 16.04 64 b

Test Case
0 Prerequisites
0.1 Import traces
1 Project View

Check analysis

1.1 can execute
Verify help
message when

1.2 applicable

Check analysis
for another

1.5 trace type
View
2 Management

Action

Import LTTng
Kernel traces in
Tracing project

In the project
explorer,
expand a LTTng
Kernel trace

In the project
explorer, open
and expand the
LTTng kernel
trace, right-click
the Input/Output
analysis and
select Help

In the project
explorer,
expand a non-
LTTng Kernel
trace

LTTng 2.0 - I/O analysis

Comment

Verification

"Input/Output”
analysis is
present and
"normal" (not

striked-out) SWTBot

A generic help
message
appears with
the name of the

analysis Manual

"Input/Output”
analysis is not

present SWTBot

Comment

Pass

Pass

Pass
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2.1

2.2

2.3

24

25

Populate
analysis's view

Open view

Close trace

Open trace

Close view

Re-open view

Open an LTTng
kernel trace and
expand the
"Input/Output”
analysis in the
project explorer

Double-click the
Disk I/0O Activity
View under the
Input/Output
analysis

Close the trace

With the view
already opened,
open the trace

Close the Disk
I/0O Activity view

Double-click the
Disk I/0O Activity
view under the
Input/Output
analysis in
project explorer.

"Disk I/0O
Activity" View
appears under
the analysis

The Disk 1/0
Activity view
opens and
triggers the
input/output
analysis. After
the analysis, the
Xy charts is
populated.

The Disk 1/10
Activity view is
emptied.

The Disk 1/0
Activity view is
populated.
The view is
closed.

The view opens
and is
automatically
populated.

SWTBot

SWTBot

Manual

Manual

Manual

Manual

LTTng 2.0 - I/O analysis
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4.1

4.2

4.3

Drag move time
range

Zoom time
range (mouse
wheel)

Drag zoom time
range

Drag move xy
chart left and
right with middle
button

Zoom with
mouse wheel up
and down,
cursor inside xy
chart

Drag select time
graph with right
button in xy
chart

Time range is
dragged. When
mouse button is
released, series
are updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out, relative to
MOUSE CUrsor.
When mouse
wheel is
stopped for a
short time,
series are
updated and
new time range
is propagated to
other views.
Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, series
are updated and
new time range
is propagated to
other views.

Manual

SWTBot

Manual

LTTng 2.0 - I/O analysis
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4.4

4.5

4.6

Mouse hover

Drag mouse
selection

Shift key
selection

Hover mouse in
xy chart region
anywhere

Drag select xy
chart with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time
(end time)

Tool tip shows
the puntual disk
activity, with
units in <unit>/s

Selection
highlighted and
selection range
is propagated to
other views

Selection
highlighted and
selection rang is
propagated to
other views

Manual

Manual

Manual

LTTng 2.0 - I/O analysis
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4.70

Drag mouse
selection
(Status bar)

Drag select xy
chart with left
button

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)

Manual

LTTng 2.0 - I/O analysis

87



4.3.0-TraceCompassTestCases

6.1

Click select with

left button

(begin time),

press shift key
Shift key and click select
selection another time

(Status bar) (end time)

Select a random
Time time in another
synchronization view

Selection
highlighted.
Status bar of
Eclipse is
updated with
time
information: T,
T1, T2 and
delta, where T
is the time of
the mouse
position, T1 the
first selected
time, T2 the
second
(draggged)
selected time
and delta the
time difference
between T2-T1
(can be
negative)

Selected time
line is updated.
If selected time
is outside
current range,
time range is
updated to
include it.

Manual

Manual

LTTng 2.0 - I/O analysis

Christophe: when
selecting a range
with shift, T2 is
always greater than
T1. When you left
click somewhere, it
becomes T1, but if
you shift+left click
on a lower time (to
the left), that
second one
becomes T1 and
the former T1
becomes T2. Thus,
T2-T1 can never be
negative.
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6.2

6.3

6.4

Time range
synchronization

Time range
selection
synchronisation

Disk I/0O Activity
works with
experiments

Select a new
time range in
Disk I/0O Activity
view orin
Histogram view.

In any other view
that supports
range
synchronization,
select a new
range.

Time range is
updated. Manual

Selection is

highlighted. If the

most left time

(TT) of selected

time range is

outside the

current range,

then time range is

updated to

include it Manual

Manual

LTTng 2.0 - I/O analysis
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Target:

0.1

0.2

0.3

0.4

1.1

Section

LTTng 2.0 - VM
Analysis

Test Case

Prerequisites

Import traces

Create
experiment

Synchronize
experiment

Set experiment
type

View
management

Analysis
present

Action

Download
traces here:
https:
/Isecretaire.
dorsal.polymtl.
ca/~gbastien/tra
cingSummit201
4/mpi_traces.
tgz and import
the 3 kernel
traces in the
vmnet directory

Create an
experiment with
the 3 traces in it

Synchronize the
experiment, it
should be
accurate and 2
of the traces will
be udpated

Right-click the
experiment,
click "Select
experiment
type..." and
select "Virtual
Machine
Experiment"

Expand the
Views element
of the
experiment

To Do

Verification

The Virtual

Machine

Analysis is

present Manual

Pass

Comment

Comment

LTTng 2.0 - VM analysis
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1.2

1.3

1.4

1.6

2.1

22

Open
experiment

Open view

Close view

Unapplicable

experiment

View
population

Populate the
view with
experiment

View guest's
threads

Open the vm
experiment in
Project Explorer

Expand the
Views element,
then the Virtual
Machine
analysis and
click on the
Virtual CPU
View

Close the
Virtual CPU
View

Open an
experiment that
is not of Virtual
Machine

'Experiment type

With the VM
experiment,
open the Virtual
CPU View

Expand the
Threads entry of
a guest

Expand the
Views element
under the trace,
then the Virtual
Machine
Analysis
element. The
Virtual CPU
view is present

Virtual CPU
view is opened,
the virtual
machine
analysis is
triggered and
the view gets
filled

Virtual CPU
view is closed

Expand the
Views element
under the trace.
There is no
Virtual Machine
Analysis.

The view is
populated with
the VM element
as the only
parent and 2
virtual guests
having 3
VCPUs each
and a collapsed
Threads entries

A list of
processes is
shown, in
numerical order
and their time
graph viewer
part is filled

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - VM analysis

VM experiment and normal experiment need visual differenciators.

launches kernel exec graph which take a very long time, slow indexing throughput

django exp
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23

24

25

3.1

3.2

VM specific
states

Preempted
thread states

Re-opening

Drag move time
range

Zoom time
range (mouse
wheel)

Zoom in the
VCPUs time
graph around
the "interesting"
region, where
there is more
action (around
the second half
of the trace)

Select a region
with the
CPU_PREEMP
TED state and
scroll down the
threads entries
to around 405-
406: mpi-
imbalance
processes

Close the VM
experiment,
reopen it

Ctrl-Drag move
time graph left
and right with
middle button

Zoom with
mouse wheel up
and down,
cursor inside
time graph while
holding the Ctl
button

2 new states
are easily
recognizable:
WAIT_VMM
and
VCPU_PREEM
PTED

We can observe
alpha'ed states
corresponding
to the cpu
preempted
states

The view is
populated again

Time range is
dragged. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.
Time range is
zoomed in and
out, relative to
mouse Cursor.
When mouse
wheel is
stopped for a
short time,
states are
updated and
new time range
is propagated to
other views.

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - VM analysis
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3.3

3.4

3.5

3.6

3.7

3.8

Zoom time
range (mouse
drag)

Mouse vertical
scroll

Vertical scroll
bar

Drag select time
range

Double-click
reset time range

Mouse hover
(empty region)

Drag in time
graph scale left
and right with
left button

Scroll with

Time range is
zoomed in and
out. When
mouse button is
released, states
are updated and
new time range
is propagated to
other views.
Table and time
graph scroll up
and down and
remain aligned.
Selected worker

mouse wheel up does not

and down,
cursor outside
time graph

Click and drag
vertical scroll
bar

Drag select time
graph with right
button

Double-click left
button on time
scale

Hover mouse in
time graph over
empty region

change. Vertical
scroll bar
updated.

Table and time
graph scroll up
and down and
remain aligned.
Selected
process does
not change.

Selection
highlighted.
When mouse
button is
released, time
range is
zoomed to
selection, states
are updated and
new time range
is propagated to
other views.
Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.
Tool tip shows
process name
only.

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - VM analysis
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3.9

3.10

3.1

4.1

4.2

43

Mouse hover
(state)

Drag mouse
selection

Shift key

selection

Keyboard
handling

Keyboard
navigation in
table (process
selection)

Keyboard
navigation in
table (tree
expansion)

Keyboard
navigation in
time graph
(process
selection)

Hover mouse in
time graph over
state

Drag select time
graph with left
button

Click select with
left button
(begin time),
press shift key
and click select
another time

‘(end time)

With focus on
table, use UP,
DOWN, HOME,
END keys

With focus on table,
in Windows use
LEFT, RIGHT keys
while expandable
element is selected

in Linux use SHIFT
LEFT, RIGHT keys
while expandable
element is selected
With focus on
time graph, use
UP, DOWN,
HOME, END
keys

Tool tip shows entry
name, state name,
date, start time, end
time, duration.

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be
negative)

Selection highlighted.
Status bar of Eclipse
is updated with time
information: T, T1, T2
and delta, where T is
the time of the mouse
position, T1 the first
selected time, T2 the
second (dragged)
selected time and
delta the time
difference between
T2-T1 (can be

| negative)

Selected entry
is changed.
Time graph
selection is
updated.
Vertical scroll
bar updated.

For expandable
element, tree is
expanded or
collapsed. Time
graph item expansion
is updated. Vertical
scroll bar updated.
For other entries, it
does nothing.

Selected entry is
changed. Table
selection is updated.
Vertical scroll bar
updated.

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - VM analysis
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4.4

5.1

5.2

5.3

5.4

5.5

Keyboard
navigation in
time graph
(state selection)

Align views

Show Legend

Reset Time
Scale

Select
Previous/Next
Event

Select Previous/Next
Element

With focus on
time graph, use
LEFT, RIGHT
keys

Click on the Align
View Button, with
another time graph
view, eg the Control
Flow view opened
above or under

Click Show
Legend button

Click Reset
Time Scale
button

Click
Previous/Next
Event button

Click
Previous/Next
Element button

Previous or next
state is
selected.
Selected time is
updated in other
views.

When it is pressed,
moving the line
between tree viewer
and time graph will
move the line of the
other view. If not
pressed, the line can
be moved without
affecting the other
views

The legend
dialog is opened
and can be
closed.

Time range is
reset to full
range, states
are updated and
new time range
is propagated to
other views.
Previous or next
state is
selected.
Selected time is
updated in other
views.

Selected entry
is changed in
table and time
graph. Vertical
scroll bar
updated.

Manual

Manual

Manual

Manual

Manual

Manual

Verified in Aug. 15-
2018 at 16:27PM

State works

LTTng 2.0 - VM analysis
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5.6

5.7

5.8

5.9

5.11

5.12

6.1

6.2

Zoom In/Out

Add Bookmark

Next/Previous marker

Delete bookmark

Do not show markers

Show markers

Synchronization-

Time
synchronization
Window range
synchronization

Click Zoom
In/Out button

Select a time, and
click on the Add
Bookmark button

Add more
bookmarks, then click
on the next/previous
marker buttons

With next/previous
marker, when on a
bookmark, click the
delete bookmark
button

Click on the down
arrow at the extreme
right of the view, then
expand Show
markers and uncheck
the Bookmarks box

Same as above,
recheck the
Bookmarks box

Select a random
time in another
view

Select a new window
range in another view

Time range is
zoomed in and
out, relative to
center of
selection or
window. States
are updated and
new time range
is propagated to
other views.

The bookmark is
added and is
displayed in the other
views as well (if
enabled)

The time graph view
navigate between the
bookmarks, States
are updated and time
selection is
propagated to other
views. When on a
bookmark, the Add
bookmark buttons
changes to Delete
bookmark

The bookmark is
deleted from all views

All remaining
bookmarks disappear
from the view, but
remain in other views
where the they are
enabled

The bookmarks come

back

Selected time
line is updated.
If selected time
is outside
current range,
time range is
updated to
include it.

Window range
is updated.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

LTTng 2.0 - VM analysis
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6.3

In any other
view that
supports
selection range
synchronization,
Selection range select a new
synchronization range.

Selection is
highlighted. If
the left time (T1)
of selected time
range is outside
the current
range, then
window range is
updated to
include it

Manual

LTTng 2.0 - VM analysis
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Section

Flame Graph

Target: Windows 7 64 bit

Step

0
1

2.1

Test Case
Download the test resources
Preparation

Open TMF Flame Graph View

Import generic trace

Import cyg-profile trace

Import cyg-profile-fast trace

Manage View

Close view

Action
Download this

Use menu
Window — Show
View — Tracing
— Flame Graph

Import a trace
that does not have
any call stack
information, like
a standard kernel
trace

Import the trace
in the "trace"

directory of the
downloaded zip

Import a trace in
the "trace-fast"
directory of the
downloaded zip

Close the 'Flame
Graph' View

Verification

Verify that 'Flame
Graph View' view
is shown

Verify that
nothing is shown
in the view

Verify that the
Flame Graph
View is populated
with some
callers/callees
information.

Verify that the
Flame Graph
View is populated
with some
callers/callees
information.

Flame Graph'
view is removed
from perspective

To Do
0
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass
SWTBot Pass

FlameGraphView

Comment

Comment
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22

23

24

2.5

2.6

2.7

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment

Restart

Close all traces

Use menu
Window — Show
View — Other ...
— Tracing —
Flame Graph

Flame Graph'
view is displayed
and re-populated

Verify that view
is populated with
Open "trace(- callers/callees
fast)" trace information
1) Close 'Flame
Graph' view
2) Open
"glxgears-cyg-
profile(-fast)"
trace located in ~ Verify that view
the git in ctf test  is populated with
3) Open 'Flame  callers/callees
Graph' view information
Open Experiment Verify that view
with 2 or is populated with
moreFlame Graph all callers/callees
traces. information
(You can use both (separated by
traces) trace).
Verify that view
Restart Eclipse  is populated with
with Flame Graph callers/callees
trace opened from trace
Verify that Flame

Close traces and
experiment one

by one from the
editor tab

Graph view is
cleared after
closing the last
trace

SWTBot

SWTBot

SWTBot

Manual

Manual

Manual

FlameGraphView
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3.1 Thread name sorting
3.2 Thead id sorting

4.1 Time synchronization
4.2 Go to maximum

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or

moreFlame Graph

traces. Then
select 'Sort
threads by thread
name'

Open a trace
multiple Flame
Graph thread or
open experiment
with 2 or

moreFlame Graph

traces. Then
select 'Sort
threads by thread
id'

Select a random
time in another
view

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
maximum'

The view is
sorted by thread
name. Manual

The view is
sorted by thread
id. Manual

Selected time line

is not updating.

Nothing happen. Manual
- The 'Call Stack'

view is populated

- The call stack

view is

synchronised to

the range of the

maximum call

duration of the

'Flame Graph'

selected entry Manual

FlameGraphView
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43 Go to minimum

Function name import

5.1 Mouse hover (empty region)

Mouse hover (state)

1. Open the 'Call
Stack' View

2. In the 'Flame
Graph' view,
right-click on a
random entry in
the graph

3. Select 'go to
minimum'

1. Open the 'Call
Stack' view with
the 'Flame Graph'
view and the cyg-
profile trace
opened

2. Import 'cyg-
profile-mapping.
txt' as mapping
text file

Hover mouse in
time graph over
empty region

Hover mouse in
time graph over
state

- The 'Call Stack'
view is populated
- The call stack
view is
synchronised to
the range of the
minimum call
duration of the
'Flame Graph'
selected entry

Manual

Both 'Call Stack'
and 'Flame Graph'
views display
function name
instead of
function address.

SWTBot

Tool tip shows
depth only

Tool tip shows
Total time and
self times with
standard
statistics.

SWTBot

SWTBot

FlameGraphView
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# Section Pass Fail ToDo Comment
Counters View 3 [ o | o o

Target:

Step Test Case Action Verification Comment

1 Preparation

Import an LTTng trace (with counters) In the project explorer, ensure the Counters view icon is only

1.1 and non LTTng traces LTTng trace (with counters): kernel VM in test-traces  strikethroughed for the non LTTng trace. Manual Pass
2  Filtered checkbox tree

2.1 Sameas1.1 Same as above The color is changed when filtering the counters Manual Pass
3  Displaying counters data

3.1 Same as 1.1 Same as above All counters are displayed Manual Pass
4  Supporting experiments

4.1 Sameas 1.1 Same as above All counters are displayed Manual Pass
5 Persistence between traces

5.1 Manual N/A
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Section # Bug Reports # Open # Fixed
Bug Reports 0 0 0
Test Case Bug Title Found Bug Report Status
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